## Contents

Getting Started .................................................................................................................. 6
  System Requirements and Prerequisites ..................................................................... 6
  Installing from the Internet ......................................................................................... 9

Introduction and Support .............................................................................................. 12
  Introduction .................................................................................................................. 12
  How To Get Support ..................................................................................................... 13
  Registration ................................................................................................................ 21

Product Registration Instructions .................................................................................... 21
  Customer Info Screen ................................................................................................. 22

Registration - entering your key code ........................................................................... 23
  Common Errors ............................................................................................................ 25

Program and Data Updates ............................................................................................. 26

Knowing Your Mail.dat Files ......................................................................................... 28

Backing Up Your Data ................................................................................................. 30

Freight Tables .............................................................................................................. 31

Palletization Plans ......................................................................................................... 32

Optional Modules .......................................................................................................... 33

DAT-MAIL Installation Guide ......................................................................................... 35
  Server Installation ........................................................................................................ 41
  Workstation Installation .............................................................................................. 45

Network Workstation Installation Information .............................................................. 45
  Network Installation .................................................................................................... 45
  Network Auto-Update System ....................................................................................... 51

Pervasive SQL ................................................................................................................ 57
  Pervasive SQL - Workgroup ......................................................................................... 57

Pervasive.SQL Installation ............................................................................................ 57
  Pervasive.SQL WorkGroup Installation ..................................................................... 57

Single User - Standalone PC or Individual Workstation .................................................. 57

Network Installation for 2 – 5 Users ............................................................................... 57

Running the Workgroup Engine as a Windows Service .................................................. 60
Installing Pervasive.SQL on Citrix................................................................................................................. 60
Pervasive SQL - Client/Server.......................................................................................................................... 62
Installing Pervasive.SQL Client/Server version for Windows: (6 or more users)........................................... 62
    Testing PSQL.................................................................................................................................................. 65
Defaults and Program Settings ......................................................................................................................... 68
    DAT-MAIL Program Setups......................................................................................................................... 68
DAT-MAIL Program Setups and Defaults........................................................................................................ 68
    Statements Setup....................................................................................................................................... 91
    8125 Print Settings.................................................................................................................................... 102
    User Prompts .............................................................................................................................................. 107
    Export ....................................................................................................................................................... 108
    Accounting (optional module) ...................................................................................................................... 109
    Confirm (optional module) ......................................................................................................................... 110
    PostalOne! (Optional, for PostalOne! Participants) .................................................................................. 112
Mail.dat File Import........................................................................................................................................ 113
    Conformance Test Engine (CTE) Validation ............................................................................................... 113
CTE (Conformance Test Engine) Mail.dat File Validation.............................................................................. 113
Conformance Testing Tab (accessed from DAT-MAIL Program Set Up)......................................................... 113
    After a File has been Imported................................................................................................................... 116
    Error Key .................................................................................................................................................. 117
    Single Mail.dat Imports.............................................................................................................................. 118
    Using the Import Daemon .......................................................................................................................... 120
Import Daemon .................................................................................................................................................. 120
    Running the Daemon from a Workstation from the Toolbar ...................................................................... 120
    Stopping the Daemon ............................................................................................................................... 122
    Suspending the DAT-MAIL Daemon .......................................................................................................... 122
    Using the Daemon to Import Intelligent Inserter "SEL" files ................................................................... 123
    Using the Daemon Auto-Start Feature ...................................................................................................... 123
    Daemon Auto-Initialize Feature ................................................................................................................ 123
Views............................................................................................................................................................... 127
    The Navigator ........................................................................................................................................... 127
    Qualification View ................................................................................................................................... 129
    Component File View ............................................................................................................................... 133
<table>
<thead>
<tr>
<th>View</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Container Quantity View</td>
<td>135</td>
</tr>
<tr>
<td>Container Summary View</td>
<td>136</td>
</tr>
<tr>
<td>Original Container Identification File View</td>
<td>141</td>
</tr>
<tr>
<td>Mail Piece Unit File View</td>
<td>142</td>
</tr>
<tr>
<td>Mailer Postage Accounting View</td>
<td>144</td>
</tr>
<tr>
<td>Package Quantity View</td>
<td>146</td>
</tr>
<tr>
<td>Piece Detail File View</td>
<td>147</td>
</tr>
<tr>
<td>Piece Barcode File View</td>
<td>149</td>
</tr>
<tr>
<td>Segment File View</td>
<td>151</td>
</tr>
<tr>
<td>Change Weights View</td>
<td>153</td>
</tr>
<tr>
<td>Entry View</td>
<td>155</td>
</tr>
<tr>
<td>Mail Schedule View</td>
<td>157</td>
</tr>
<tr>
<td>Mother Pallet View</td>
<td>160</td>
</tr>
<tr>
<td>Transportation View</td>
<td>163</td>
</tr>
<tr>
<td>Generate Statements View</td>
<td>164</td>
</tr>
<tr>
<td>Floating Batch Manifest View</td>
<td>165</td>
</tr>
<tr>
<td>File Information View</td>
<td>166</td>
</tr>
<tr>
<td>Job/Mailer Information View</td>
<td>167</td>
</tr>
<tr>
<td>DropShip Database</td>
<td>168</td>
</tr>
</tbody>
</table>
Welcome to the DAT-MAIL User Guide online help system. Browse through the help pages by clicking on the icons below or selecting pages in the table of contents to the left. To quickly find specific product information, enter search criteria in the search box above and click the search button.

If you're unable to find what you're looking for in this help system, try these alternative resources:

Our Website
Knowledgebase

or contact our support team:
Email: techsupport@windowbook.com
Phone: 800-370-2410
Getting Started

System Requirements and Prerequisites

System Requirements

Window Book Policy with regard to Microsoft Products

Window Book follows Microsoft’s published time line for phasing out support of retired MS products. For more detailed information and specific dates on Microsoft’s Product Life cycles, please visit Microsoft's web page on this subject:

http://support.microsoft.com/lifecycle/

Single User System

Recommended: Pentium 4 processor or better

- 2.2 GHz or better
- 1 GB RAM or more
- 20 GB free on hard drive for DAT-MAIL data (7200 RPM hard drive or better)

Display adapter resolution must be able to accommodate 800 x 600 or greater display mode.

- Desktop Operating System: Windows XP Pro, Vista, Windows 7

Network Workstation

Minimum Requirements: Pentium 4 processor or better

- 2.2 GHz or better
- 1 GB RAM or more
- 10 GB free on hard drive for DAT-MAIL data (7200 RPM hard drive or better)

Display must be able to accommodate 800 x 600 or greater display mode.

- Desktop Operating System: Windows XP Pro, Vista, Windows 7
Server and Network

Recommended Requirements:

- Dedicated server for the product.
- 2 GB RAM or more
- 50 GB hard disk space
- 2.2 GHz Pentium 4 processor or better

100 mbps is minimum recommended network speed. Use switches instead of hubs for best results

- Server Operating Systems: MS Server 2003 or higher

For more information on Pervasive.SQL Server System Requirements, please visit their web site at www.pervasive.com
Software Prerequisites

During the first time DAT-Mail program installation, there are prerequisites that are also installed:

(Note: these can be pre-installed by the user, or they will be installed by the DAT-MAIL installation routine if they are not found to exist on the machine already).

1. **The installation of Pervasive SQL v11 is required.**

- Pervasive.SQL is a well-known and highly regarded SQL database engine that provides reliable data access and overall performance.

- If your Dat-Mail registration is for 1 to 5 users on a Windows based server or a standalone configuration, the installation will install Pervasive SQL Workgroup Edition on the server and the PSQL Client on the workstations (when you choose "workstation" during the installation). Pervasive must be installed on the server and workstations that will be accessing Dat-Mail. Please contact your Sales Representative to get your license key.

- If your Dat-Mail registration is for a network installation with 6+ concurrent users, you should choose Pervasive SQL Client/Server during the installation. Workstation installation will install the PSQL Client. Please contact your Sales Representative to receive your license key.

**IMPORTANT NOTE:** Starting with PSQL version 11.0 licenses can only be applied to one machine at a time. Applying the same key to a 2nd machine will fail.

2. **The installation of Microsoft .NET Framework version 3.5+ and 4.0 are required.**

These will be installed by the installer the first time the installation is run on the machine. Internet access is required for these prerequisites to be installed successfully.
Installing from the Internet

Installing DAT-MAIL from the Internet

The main way that the product is delivered is through the Window Book Inc. website (www.windowbook.com). The Software Updates page contains downloads for the latest installation routine of DAT-MAIL (Both 64-bit and 32-bit versions - you must choose the correct one for your operating system). In addition the page contains Release Notes for each version as well as interim (unreleased) versions so you can see information on the new features added and any other important information on the program with each new release.

Click the "Downloads" text on the www.windowbook.com main page to get to the Software Updates page, then choose the product you are upgrading to (in this case DAT-MAIL) from the grid on that page.
Main Software Downloads page:

From here, click on "DAT-MAIL" to go to the individual DAT-MAIL page and download the program, read Release Notes, etc.
Note: This page often contains critically important communications about the latest release of DAT-MAIL - It is useful and necessary to read the Release Notes and any special messages pertaining to each release that may be posted here.
Introduction and Support

Introduction

What can DAT-MAIL™ software do to help your operation? Here is an outline of the different options available.

Contact your Window Book Client Services Representative, or email sales@windowbook.com.

DAT-MAIL™ Editor

- Imports and validates Mail.dat files
- Facilitates Mail.dat edits
- Creates mailing statements for Mail.dat and non-Mail.dat mailings
- Provides flexible, accurate postage statement options
- Maintains your own client, job and permit databases
- Provides sophisticated, useful production reports
- Prints barcoded sack and tray tags
- Prints barcoded pallet placards and skid sheets
- Optimizes drop shipments with Quick Plan Entry Point processing
- Supports USPS electronic acceptance and verification
- Supports PostalOne!®
- Easy to install and implement quickly

Easy to Upgrade to Toolbox

DAT-MAIL™ Toolbox
All of the functions, tools, and features of Editor, PLUS

- Palletization Module included - Tray and Sack Palletization/Co-palletization
  Build ‘convenience’ pallets for non-palletized mail, or build USPS Sorted pallets from scratch.

- Freight Cost Analysis - 'Planalyzer'
  Optimize your transportation plans, taking both freight cost and delivery speed into account. Reduce costs by allowing users to quickly and easily preview different mailing options, i.e. to "comparison shop" for the very best transportation values. Also includes Multi-Job Freight Planning option for merged Mail.dat files.

- Drop Ship Database
  Includes detailed, updated information on over 33,000 DDU, SCF, ADC and BMC destinations.
How To Get Support

Resources, Help, and Support are accessible from right within your program!

Click on the Help listing for the following:

<table>
<thead>
<tr>
<th>Help</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>User Guide</td>
<td>F1</td>
</tr>
<tr>
<td>View Product-related Messages</td>
<td></td>
</tr>
<tr>
<td>Check For Updates</td>
<td></td>
</tr>
<tr>
<td>Update Program</td>
<td></td>
</tr>
<tr>
<td>Get Support for DAT-MAIL</td>
<td></td>
</tr>
<tr>
<td>Online Learning Center</td>
<td></td>
</tr>
<tr>
<td>Registration</td>
<td></td>
</tr>
<tr>
<td>Product Information</td>
<td></td>
</tr>
<tr>
<td>Make a Suggestion</td>
<td></td>
</tr>
<tr>
<td>About DAT-MAIL</td>
<td></td>
</tr>
</tbody>
</table>

**User Guide**

Access the full User Guide for DAT-Mail from this menu listing, or by hitting your F1 key. The Full User Guide, plus the DAT-Mail Quick Start Guide is available on the Window Book website at [www.windowbook.com/userguides](http://www.windowbook.com/userguides)
Check For Updates

With an open Internet connection, you can click on "Check For Updates" to check your program version and compare it to the latest public release. A web page appears with information on the latest DAT-MAIL Version. If you need to update, you can do so by clicking the "Download Now" button for the appropriate version.
"Update Program" gives you access to three choices. To use these options you must have an open Internet connection, and **All users must be out of the program** (if you are running a network version) before running any of these update maintenance functions.

**Full Program Download:** Clicking here takes you to the DAT-MAIL Update page, complete with important Release Note information, Update Notes, and access to the download itself. You will need to download the installation file then run it to update the software. It is not recommended to run the installation program directly from the website before downloading it. See detailed instructions on this page as well.
Get Support For DAT-Mail

This is the most important tool you have for getting Technical Support in the quickest, most efficient manner possible. All Tech Support requests should go through this system.

Incoming questions/problems are routed directly to the first available support representative best qualified to handle your particular query. Incidents are handled quickly and efficiently.

Follow these steps to get your Incident resolved:

**STEP #1 Search the database**

**INSTANT ONLINE ANSWERS**

Clicking here will bring you to Instant Answers Online. All resolved queries are stored in our solution database. Search by product, category, keywords, or phrases. This resource is available 24 hours a day. In many support cases, you will find the answer you are looking for here, and be able to resolve the situation quickly with the information provided. This may be the only step you need to take. If you cannot find the answer to your particular incident, go to STEP 2

**STEP #2 Ask a Question**

**SUBMIT A QUESTION ONLINE**

Submit a question to our technical support staff. Be sure to scroll to the bottom of the question form and click on the "Submit" button. You will receive both instant on-screen verification and an e-mail with your incident reference number, confirming that your query has been received and routed to achieve the fastest resolution possible. Use your incident
number in future correspondence to help speed resolution. A support representative will help you resolve your incident.

The Knowledge Base support system also gives you access to the following:

**My Stuff** - Login to check the status of your questions, modify your answer update notifications, update your personal profile, or access restricted information and features.

**Provide Feedback** - Submit a suggestion, complaint, or other feedback about this site or any of our products and services here.

As more incidents are logged and resolved the database becomes more and more powerful and dynamic in serving your needs. Be sure to take full advantage of this support system!

**Join A Support Session** - When your Tech Support person directs you to enter into an Online Support Session, you can access it quickly and easily from here.
Registration

Access your Customer Information Screen, or the screen for entering Registration Codes.

For detailed instructions on how to enter Customer Information and Registration Codes, refer to the "Registration" section in this Guide.

Online Learning Center

Click on "Online Learning Center" for free access to all of our online Training Tutorials.

Product Information

Click on "Product Information" to choose either the Window Book main website, or the DAT-Mail product page.
About DAT-MAIL

Click on "About DAT-MAIL" to bring up this screen:

**MORE About:** Gives you access to Database Version Info, DM Registered Options, and a lot of Environment information. This is often very useful diagnostic information for Window Book technical support.

**What's New - Database:** Gives you access to database read-me information.
Technical Support Via The Web:

You can access support from any of the www.windowbook.com webpages via the Tech Support icon:
Registration

Product Registration Instructions

Registration prompts will come up immediately upon opening the program for the first time, as well as when opening an expired program. This can also happen if you are setting up a network workstation and have chosen an incorrect path for "Netbookshelf". After you click the OK button, you will immediately get the Customer Info screen (below) where you can enter your company information.

You can access the registration screens in an unexpired program from the "Help" menu by selecting the "Registration" option. This is where you enter a new registration code if you are "test-driving" a new optional module for the program or if you have recently renewed your subscription. You will receive a registration expiration warning message 14 days in advance upon opening the program alerting you that the program will be expiring. This message can be suppressed up to 7 days before the expiration date and will then appear every day until you enter a new registration code.
Customer Information Screen

Red* Fields are required.

We ask that you provide two contacts, one as the primary technical expert or main user, the other as the billing or purchasing agent. This information helps us communicate with you as needed.
Registration - entering your registration key

If your Registration Key is current, it will be shown, along with an expiration date.

Here you have the option to Print a Request Form to be faxed or enter the registration key you received via e-mail from our registration department.
Cut and paste the key into the Registration slot then click the Save Registration Key button to register your product:

**Type your new Registration Key into the entry field below. If you’ve already copied it, simply paste it into the field.**

To paste Registration Key: Type Ctrl-V, or Right-Click the mouse and select “Paste”

[Open Customer Info Screen]

**Registration Wizard for: DAT-Mail**

**UNREGISTERED PRODUCT**

You have successfully entered a new registration key. Press the “Save” button to store it away.

This is your new Registration Key

[Save Registration Key]
Common Errors

There may occasions when entering your registration code results in an error. Here are a few of the common error messages and how to deal with them:

Error #20: The Registration Key has been rejected because error condition #20 has been reported. There are two reasons for an error #20. This can happen if you attempt to enter a registration code into the wrong program. For instance, you received a new registration code for Tag Master but tried to put that code into DAT-MAIL, Post Master, Complete Postal Library, etc.

Another possibility is an incorrect system date. Go to the bottom right side of your screen and check the Date/Time of your computer then make any necessary adjustments.

Error #21: The Registration Key has been rejected because error condition #21 has been reported. This error occurs when the address information supplied to your Sales Rep is different than the one that has been entered into the Customer Info screen. Window Book uses the originally supplied information to generate your registration code. You can either contact your Sales Rep to have the original information changed OR you can use the Open Customer Info Screen button to change your address.

Note: If there is a prior existing registration code (i.e. this is a renewal) and the company has a new address you will need to contact our registration department for a corrected code (This condition requires a special "reset" code).
Program and Data Updates

Pop-up warning message - What does this mean?

15 days prior to the Mandatory Expiration Date of the program’s Destination Database, you will see pop-up messages like the one above. You will continue to be prompted each day, until the Destination Database files have been updated. Updates can be downloaded to your desktop from the Window Book website, and then run. Follow the prompts to update your programs.

What are Destination Database Updates?

Destination and Labeling List files are Database updates from data converted from USPS sources for use in claiming Destination Entry Discounts in postage, such as NDC, BMC and SCF discounts. These updates also include pertinent information to allow correct printing of Pallet, Tray, and Sack tags.

Why are Destination Database Updates required?

The USPS requires that this information be updated in order to claim mailing rate discounts.

We take their information from several sources, process it, and make it available to users via the web for updating.

How often are mandatory updates released?

Mandatory Data Updates are issued at least four times per year when the USPS issues new labeling lists. With the USPS updating their destination files daily, we strongly encourage updates on no less than a weekly basis as part of your regular program maintenance.

Additional mandatory updates of DAT-MAIL itself are at times required in order to accommodate required USPS form and rate changes.
How do I update my program?

Refer to the section titled How to Get Support, specifically "Check for Updates"

You can also get full program updates online anytime at our Software Updates page: http://www.windowbook.com/softwareupdates/

**Important Note:** Be sure to review the Update Notes prior to installing an update.
Knowing Your Mail.dat Files

Mail.dat is a series of files that describe, in detail, how a mailing has been presorted. The first part of the file name is the same for all files in a set and is usually related to the job number. For example, the Mail.dat file names for job 123456 would be 123456.hdr, 123456.seg, 123456.csm, etc.

The files are labeled below as "Required", "Choice", or "Optional":

**HEADER (.HDR) Required**
Identifies creator, Mail.dat version used, total file record count (for validations), as well as handling history.

**SEGMENT File (.SEG) Required**
Identifies each presort group. Mail that requires different processing from other pieces in the same mailing are separated by segment. Segmenting should not be used to differentiate Entry Points, unless the pieces are being processed in different categories. Segmenting should also not be used as a work-around for reporting, especially when the reporting information is contained in another accessible area of Mail.dat.

**MAIL PIECE UNIT (.MPU) Required**
Details the physical attributes of each individual mail piece, such as piece weight and (in the case of Periodicals), ad percentages. Commingled mail, Co-palletized Mail, or other non-identical piece weight mailings can have multiple Mail Piece Units associated with a Segment; otherwise a Mail Piece Unit ID cannot cross Segment.

**MAILER POSTAGE ACCOUNT FILE (.MPA) Required**
Each Mail.dat file must have at least one MPA record. This file contains the Full Service By/For information and information on postage payment.

**COMPONENT (.CPT) Required**
Gives us the class, weight and dimensions of every mailing component. There can be multiple components, even of different classes, in a single mailing. The file defines each part of the Mail Piece Unit by the mail class.

**MPU / COMPONENT RELATIONSHIP FILE (.MCR) Required**
The MPU/Component Relationship file is a table relating the two variables.

**CONTAINER SUMMARY (.CSM) Required**
This file tells how many pieces are in each tray and what the presort level of the tray is. It contains a record for each sack, tray or pallet (flats on pallets) and can indicate which mother pallet a sack or tray is located on, and what kind of pallet that is. This file also contains other critical information such as entry point, mail date and other information which makes this file the heart of the Mail.dat file set. Also contained in this file is the label information needed to print flags and bag/sack/tray tags.

**CONTAINER QUANTITY (.CQT) Required**

28
This file tells us how many pieces qualified at which rate levels within each container (tray, sack or pallet).

**Package Quantity (.PQT) Choice**
This file tells us where each package or bundle is going, and how many pieces are in each. Information from this file is required to properly print the qualification reports. This file is required also for PostalOne! in other cases, use of this file may be optional.

**Piece Detail File (.PDR) Choice file, used with .PQT**
This file is used in manifest mailings and contains one record for each piece in a mailing.

**Piece Barcode File (.PBC) Choice file, used with .PQT**
An alternative to .PDR, this file contains the barcode information for the pieces in a mailing.

**Component Characteristics (.CCR) Optional**
This file is used to claim Incentives and/or Fees offered by the USPS.

**Original Container (.OCI) Optional**
This file is used to link new containers to original containers when performing CoPal processing.

**Walk Sequence File (.WSR) Optional**
This file is required when claiming Walk Sequence discounts.

**Seed Name File (.SNR) Optional**
This file may be used in conjunction with USPS Confirm or other tracking/quality control initiatives.

**Special Fees and Charges File (.SFR) Optional**
This file is for use with Insured, Delivery Confirmation, and Signature Service mailings.

**Postage Adjustment File (.PAR) Optional**
This file can be generated by DAT-MAIL when you choose to mark a pieces as spoiled or shorted.

To learn more about Mail.dat files, we recommend you go to the source - see the IDEAAlliance Mail.dat page at [http://www.maildat.org](http://www.maildat.org)
Backing Up Your Data

Backing Up/Restoring your Data

Backing up DAT-MAIL data is easy and highly recommended! File corruption errors can be difficult to repair or may even be unrecoverable in some cases. Having a ready backup of your data gives you the option of restoring from backup and continuing quickly. If your single-user PC crashes, you'll be able to move your existing data to a new computer rather than having to start your database from scratch.

If you are using DAT-MAIL from a shared network it is a good idea to ask your Network Administrator what kind of backup routine they have in place in case you are ever advised by Window Book Tech Support to restore the data.

To back up your data, copy these files to a separate location. How often you do backups is up to you. If you have a lot of data on a daily basis, you may want to back up these files at a specified time each day. Or you can back up on a weekly or monthly basis, depending on usage.

**Note:** The installation routine will back up your critical data (see below) with each update. However you may want to set up a system to do more regular backups, particularly if you are a high-volume mailer.

---

**Critical Data:**

On a standard installation the following data files are located in the (drive letter):\WB\PMW\DATA directory. You can find out which directory your active data files reside in by doing a Windows Start->Find->File and searching your installation drive (local or network) for one of these files:

**Default Settings:**

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PMWS.INI</td>
<td>Statement/8125 program setup defaults</td>
</tr>
<tr>
<td>MDBMDC.INI</td>
<td>DAT MAIL program setup defaults</td>
</tr>
</tbody>
</table>

**Postage Statement Data:**

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAIL.DAT</td>
<td>Statement Headers</td>
</tr>
<tr>
<td>MSD.DAT</td>
<td>Statement Detail</td>
</tr>
<tr>
<td>CL2.DAT</td>
<td>Periodical Detail</td>
</tr>
<tr>
<td>JOBDIST.DAT</td>
<td>Job Distribution</td>
</tr>
</tbody>
</table>

**Drop Ship Data:**

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DSF.DAT</td>
<td>8125's</td>
</tr>
<tr>
<td>PV3602.DAT</td>
<td>Consolidated Statements</td>
</tr>
<tr>
<td>BOL.DAT</td>
<td>Bills of Lading</td>
</tr>
</tbody>
</table>
Accounting Files:

- **CHECK.DAT**: Checks
- **PMT.DAT**: Payments
- **PAR.DAT**: Accounting Records
- **CKACCT.DAT**: Checking Accounts
- **INVOICE.DAT**: Invoices
- **INVDETAIL.DAT**: Invoices Details
- **PARCHG.DAT**: Accounting Charges
- **XFERS.DAT**: Transfers
- **METSTMP.DAT**: Meter and Stamps

Master Files:

- **CONTROLS.DAT**: Company
- **DEFAULTS.DAT**: Statement Defaults
- **DFL.DAT**: Statement Defaults (continued)
- **CAPSID.DAT**: CAPS ID Records
- **CLIENT.DAT**: Clients
- **JOB.DAT**: Jobs
- **MAILCODES.DAT**: Mail Codes
- **PERMIT.DAT**: Permits
- **MAILOWNER.DAT**: Mail Owners
- **CARRIER.DAT**: Transportation Carriers
- **CL2PUB.DAT**: Publications
- **COMPANY.DAT**: Company (continued)
- **EMPLOYEE.DAT**: Employees/Users

---

Imported Mail.dat Files

**Critical Data**: On a standard installation the following data files are located in the (drive letter):\WB\MDV\DATA directory. You can find out which directory your active data files reside in by clicking on Help->About->More About->Environment tab or by doing a Windows Start->Find->File and searching your installation drive (local or network) for one of these files:

**MDIMPORTLOG.DAT**: Imported files listing

**\MAILDAT DIRECTORY AND CONTENTS**: Sub directory of (drive letter):\WB\MDV\DATA where all of your imported Mail.Dat files are stored.

These two items must be backed up and restored as a set.

---

**Freight Tables**

Many users have a great deal of time and work invested in creating and maintaining their Freight Tables.
**Critical Data**: On a standard installation the following data files are located in the (drive letter):

\WB\MDV\DATA directory.

**MDBFGH.TPS**  Freight Table Log

\FGTTABLE DIRECTORY AND CONTENTS  Sub directory of (drive letter):
\WB\MDV\DATA directory.

These two items must be backed up and restored as a set.

---

**Palletization Plans**

**Critical Data**: On a standard installation the following data files are located in the (drive letter):

\WB\MDV\DATA directory.

For those customers who have customized Palletization plans that they would like to be able to back up.

**MDBPLP.TPS**  Palletization Plans

---
Optional Modules

**Postage Accounting Module**

DAT-MAIL Editor or DAT-MAIL Toolbox

* Utilize the postage data to manage postage funds
* Account for all client postage funds
* Simplify management of all postage funds
* Be alerted to Permits without adequate funding
* Put Permits/Clients on credit hold lockdown
* Provides valuable analysis data and reporting
* Close a job and transfer overpayment with several options
* Print postage purchase checks
* Track accumulated meter and stamp spoilage and USPS reimbursements
* Keep track of Multiple checking accounts
* Suppress reporting on completed jobs without purging the data

**Palletization Module**

DAT-MAIL Editor (included with DAT-MAIL Toolbox)

* Create pallet placards and barcoded skid sheets
* Create and manage ‘courtesy pallets’
* Automatically fill in pallet counts on postage statements
* Supports sack and tray co-palletization for Standard Mail

**Confirm Module**

DAT-MAIL Editor or DAT-MAIL Toolbox

* Support for USPS Confirm® program for Mail Tracking & Reporting
* Provides required barcoded USPS forms such as 3152-A and 8125s
* Create and upload data required
* Supports multiple PLANET Codes®
* Supports TrackMyMail.com programs
* Utilize Mail.dat® PLANET Code® data to create statements (DAT-MAIL only)
Manifest/Spoilage Module
DAT-MAIL Editor or DAT-MAIL Toolbox

* Track spoilage
* Remove spoilage from your postage statements
* Remove spoiled pieces at their actual postage rates

Business Management System Interface Modules
DAT-MAIL Editor or DAT-MAIL Toolbox

* Pro-Mail
* Mail-Shop by Virtual Systems Corporation
* PrintStream by Streamline Solutions

ODBC Connect Module
DAT-MAIL Editor or DAT-MAIL Toolbox

* Bring in external data from other applications
* Reduce data entry
* Associate statements with valid job numbers
* Maintain Job, Client and other files in only one system
* Enhance your ability to automatically generate statements (DAT-MAIL only)

Drop Ship It Module
For DAT-MAIL Editor (included with DAT-MAIL Toolbox)

* Access USPS Drop Ship information in an easy to use format
* Includes directions to facilities
* Detailed delivery requirements including dock information
* Allows for data to be printed or exported
DAT-MAIL Installation Guide

Standalone Installation

A standalone installation on a single machine is the simplest DAT-MAIL installation. We recommend that you use the default directories for the DAT-MAIL program and data paths as the most straightforward solution.

First-time Installation:

If you are installing for the first time prerequisites such as .NET Framework 4.0 and Pervasive SQL are installed by the installation routine so that you do not have to install them separately. For these one-time prerequisite installs to work, internet access during the installation is also a requirement. MS SQL is a requirement as well. On a first-time installation if no SQL database is found the installer will install MS SQL Express, then ask you to create a connection to SQL:
To use an existing SQL Server choose this option. A search will take place - the search will find all instances of SQL available through the network, then it will prompt you to connect to the correct server from a drop-down list of all SQL instances found:

Microsoft SQL Server Instances
Please select a Microsoft SQL Server instance to connect to.

Instance Name: XPTEST01\SQLEXPRESS
Port: 1433
Authentication Mode: Windows Authentication

Finally a test is performed to make sure the MS SQL instance can be accessed:

Success!
Connection test was successful.
Click through the prompts and choose the Program and Data paths you wish to use (again on Standalone single-user installations we recommend taking the default directories).

After this is complete a set of SQL maintenance scripts will be run in addition to the DATMAIL regular files being installed. (These scripts also run during an update of an existing installation):
Please wait while Setup installs Window Book DAT-MAIL (x64) - AU.

IF EXISTS (SELECT name FROM sys.databases WHERE name = 'Nwdbb')
BEGIN
  Declare @dbpath nvarchar(250)
  
End

Window Book, Inc.
Update installation of an existing program:

For your convenience the install routine will find the existing Program and Data directories and continue with the installation - you can make changes if necessary by clicking the "Show dialogs" checkbox during the installation:
With "Show Dialogs" checked:

**Note:** If this box is not checked the installer will proceed directly to the installation without prompting for Program and Data paths.
Server Installation

DAT-MAIL Server Installation

The Server Installation is similar to the Standalone Installation with some important differences.

The main difference is that the Server Installation includes a dialog for entering the Directory called the "NetBookshelf" which stores data that is used to update the workstations when they start up. (See **Network Auto-Update System** for more detailed information)

The second difference is that the Server installation will be creating datapaths and installing data to drives (or UNC Paths) that are shared over the network so that the workstations will also have access to the data.

![Installation Options for Window Book DAT-MAIL (x64) - AU](image)

In our example the Datapaths are on the shared "O:" drive.

These drives could also be local machine drives that are shared through the network, for
instance C:\Postal\Windowbook\WB\MDV\Data where the directory "...\Postal\..." is shared across the network.

The program path, however should always be local on the server machine, and (normally) does not need to be shared.
NetBookshelf:

Choose or Confirm NetBookshelf - Note: NetBookshelf is a shared network location for shared registration information for the program.

IMPORTANT - Please Read:

NOTE: For Server Installations: NetBookshelf will be used to update workstations if you are using the Window Book - program local, data on the network - type of Workstation.

It is necessary for NetBookshelf to be accessible by all workstations in order for the program to be able to update through the network upon startup of each workstation. We do not recommend changing NetBookshelf after it has been set on the network unless absolutely necessary.

Choose or Confirm NetBookshelf below:
(NOTE: NetBookshelf should not be the same location as the data directory)

Proposed NetBookshelf Location:
C:\W\W8

Disk space requirements:

- Available: 781,751 MB
- Required: 638,501 KB
- Remaining: 751,128 MB
SQL tables are updated with each installation using SQL Scripts:
Workstation Installation

Network Workstation Installation Information

DAT-MAIL allows multiple users to simultaneously access shared data on a network. The program can be loaded and run from a local drive and shares the data from the network drive. Window Book recommends this option and the installers are designed with it in mind.

**Note:** The old system of using network drives for both the program and data is no longer recommended and may cause problems eventually.

Network Installation

Setting up a network requires two installations - First the Server (or Primary installation) on the server, followed by Workstation installations on each Workstation.

The DAT-MAIL Installers will install any prerequisites that may be required on new machines that did not previously run DAT-MAIL. Once the Server and workstation installations have been completed the DAT-MAIL Network Auto-Update system will allow the workstations to be updated without requiring full installations in the future (although there may be rare exceptions to this when a full installation is required).
MS SQL installations are not allowed on a workstation - the only installation that may occur is the SQL Native Client if the workstation does not already have that SQL component. Once that is complete, or an MS SQL instance is detected through the network you must choose the following to connect to the MS SQL database.
Window Book DAT-MAIL (x64) - AU Setup

**SQL Server Setup Information**

- Using MS SQL Server -

Window Book is actively developing programs that currently use MS SQL Server as adjuncts to DAT-MAIL and further programs of this kind will be developed. We recommend that you use MSSQL (if not already in use) to get the most from your Window Book Products.

**SQL Server Source**

- Use an existing SQL Server

**Installation Options Help**

1. Select a SQL Server from the "Instance Name" Dropdown List.
2. If the list is empty or a known SQL Server is not listed you may type the Server name and optionally the Instance name e.g. MYSERVER \SQLSERVER. Optionally enter a Port if needed.
3. Click "Next" to test the connection using the selected Authentication Mode.
After you have chosen your SQL database - Choose the program folder - which should be a local directory on the actual workstation:

Then choose the datapaths which should be shared across the network, via mapped drives or UNC paths:
The installation will continue to the end.

Also important is the Netbookshelf, which is used to store update files from the Primary / Server installation. The "Netbookshelf" location must be same physical location as the Netbookshelf that was entered during the Server installation.

**Note:** the drive mapping can be different as long as the physical location is the same.
In a Network/Workstation setup the Server or primary installation **must be done first** in order for the Network Auto-Update system to work properly. The Server installation creates a file that has information about the latest version (and files that are checked before startup) - if this file is missing the Workstation installation will give a warning error "Can't find WBProducts.ini file" during the installation.

With this file missing the program will not work properly from the workstation after being installed - it is necessary to create the file using the Server or primary installation.
Network Auto-Update System

THE DAT-MAIL Network Auto-Update system

Description:

The DAT-MAIL Network Auto-update system is designed to allow automatic updates to each workstation on a Client-Server type installation, rather than requiring a full installation on each workstation every time a new version of the program is released.

Note that to set up the system initially it is required to run the install on each workstation once, using the "workstation" option of the installer. This will also install the prerequisites (.NET Framework, MS SQL and Pervasive SQL) correctly on each workstation.

Overview: The Network Auto-Update works as follows -

1. The Server or Primary installation is updated with a new version of the program, using the "Server" option of the installer (required).

2. During this installation DAT-MAIL program files are copied to a common location, shared by all the workstations (the "Netbookshelf").

3. When DAT-MAIL starts up on a workstation it checks a file in Netbookshelf which tells it what the current version is. If the workstation version does NOT equal the Server version, an update occurs - files are copied from the Netbookshelf to the workstation. The program on the workstation then restarts with the correct version (the one that is = to what has been installed in Step 1 to the server).

Detailed instructions

Follow these instructions to set up the system

DATMAIL Auto-Updater version:
This new version of the program from Window Book allows for automatic updates of each workstation once the Network/Server installation has been completed. Note: The DAT-MAIL Server or Primary installation is always done first – it must be in place before any workstations can be updated.

In order to make this possible some changes were made to the installers and the architecture of the Server/Workstation type of Installation:
The Installer has three options, and it’s very important to do the correct type of install in the correct place, i.e. “Workstation” on the client/workstations and “Server” on the Server or primary machine (where the Main Program and (sometimes) the data are physically located.) If the program and data are on separate machines it will be necessary to designate one of the machines as the Primary or Server install for the purposes of this type of architecture.

Screen shot:

![Image of installation options]

The three options will translate into new codes in WBInstall.ini:

```
DM707Netversion=W for a Workstation (same as before)
DM707Netversion=ST for a Standalone
DM707Netversion=SERVER for a Server
```
Continuing with the Server Install – this screen now appears after the screen where you set the program and datapaths:
NetBookshelf is important since it’s the repository of the files that will do the workstation updates. The Netbookshelf MUST be available through the network to all workstations. (the aliasing can be different, for instance a workstation might see this same directory as “Z:\WB” or “\\Server01\Postal\WB” but the physical location has to be the same).

New files are being installed into Netbookshelf – these are the files that will update the workstation on startup.

There is a new directory called ...\Installs (Here Netbookshelf = O:\WB, so the full path is O:\WB\Installs) which has subdirectories that contain the DAT-MAIL files that are then updated on the workstation.

See Screenshots:
The batch file “UpdateDatMail.bat” does the actual copying of files.

There’s also a new file called WBIproducts.ini (which is created and maintained by the Server installation) which tells the workstation whether it needs to update or not:

It contains the version number of DAT-MAIL that has been updated by the Server installation. It also has a list of files to check being open on the workstation – if it finds any of these programs running you will get a warning when you start up the workstation (when an update is required).

**Note:** The Workstation installation will issue a warning if this file (WbiProducts.ini) is not found in the NetBookshelf.

**Typical Contents of WbiProducts.ini:**

```ini
[DAT-MAIL]
Version=8.1.5.2
Installer=Installs\UpdateDatMail.bat
ManualInstall=0
ActiveServerInstall=0
ServerPath=O:\WB

EXEFiles=14
File1=MDARC707.exe
File2=MDBMJEX707.exe
File3=MDFA707.exe
File4=MDLCKMGR707.exe
File5=MDMRG707.exe
File6=MDPL707.exe
```
File7=MDSCAN707.exe
File8=MDWT707.exe
File9=WBIServiceManager707.exe
File10=SPUTIL707.exe
File11=PMWiz707.exe
File12=pmwRPT707.exe
File13=pmAsnEmdSvc707.exe
File14=pmFUTILS707.exe

Display1=DAT-MAIL Archiver
Display2=DAT-MAIL Multi-Job Postage Data Feed
Display3=DAT-MAIL FAST Updated Utility
Display4=DAT-MAIL Locked Job Manager
Display5=DAT-MAIL Merge Process
Display6=DAT-MAIL Palletization
Display7=Batch Barcode Scanning
Display8=DAT-MAIL WorkTickets
Display9=Window Book ServiceManager
Display10=DAT-MAIL Spoilage Tracking
Display11=Spreadsheet and Report Generator
Display12=Reports
Display13=ASN/EMD FTP Service
Display14=Statement File Utilities

NOTES:

1. If the “ManualInstall” parameter is set to =1 then a full workstation install using the installer is required on each workstation (may be necessary in rare cases).

2. If a Server installation is IN PROGRESS the ActualServerinstall parameter is set to =1 and the workstation won’t be able to run (Error message is “Server installation in progress”) until the server install is complete.
Pervasive SQL

Pervasive SQL - Workgroup

Pervasive.SQL Installation

Pervasive.SQL WorkGroup Installation

Introduction

In order for Window Book Inc. to provide reliable data access and overall performance of its products, a data format called Pervasive.SQL (PSQL) is used. Pervasive.SQL is a well-known and highly regarded SQL database engine which allows for data stability, reliability and improved performance.

Note: The DAT-MAIL installer will install Pervasive SQL as one of the installation prerequisites.

Single User - Standalone PC or Individual Workstation

For this installation nothing is required - the installer will install the latest version of Pervasive SQL (PSQL) during the installation process, (If PSQL is not found to already exist on the computer). A reboot of the computer to enable the database engine will take place after the install is complete.

Note: Administrative Rights are required to complete the installation.

Once the product is paid for a permanent license key will be issued. Until that time a temporary 30-day license is in effect. New users will receive a separate PSQL license key once you have purchased your Window Book program.

Note: As of version 11 of Pervasive SQL license keys are non-transferable and can only be used on one machine at a time. There is a process for moving the key if you switch to a different machine if or when the original machine fails or is replaced.

Network Installation for 2 - 5 Users

Procedure:

1. Install Pervasive.SQL Workgroup version during the Server/Primary installation of DAT-MAIL. The machine will be rebooted as part of the installation.

Note: You will be prompted during the DAT-MAIL Server installation for PSQL "Client/Server" or "Workgroup": Choose the "Workgroup" option if you have a 2 - 5 user network.
2. Run the full DAT-MAIL installation on each workstation - Pervasive.SQL Client 32-bit version will be installed as one of the prerequisites. **Note:** The 32-bit version is necessary even in a 64-bit environment. No license key is necessary on the workstations - only apply the license key to the Server/Primary installation.

**Note:** Administrative Rights are required to complete the installation for both Server and Workstations.

3. After you have installed the program on each workstation, a reboot will take place.

4. Configuring Pervasive.SQL as a Permanent Gateway on the Server (see instructions below)

**NETWORK SETUP 2 - 5 USERS**

**How to set up Pervasive.SQL as a Permanent Gateway**

Procedure for setting up a Permanent Gateway on 2-5 User Networks:
With DAT-MAIL 8.01 or higher on the Server:

1. Run the program from the Server

   2. With the program running
      (for DAT-MAIL, you will need to launch the STATEMENTS side of the program by
         clicking on the 3602 icon in order to create the .LOC file)
      Right click on the following file in the program's data directory*:
         ~PVSW~.LOC

3. Click Properties - make the file READ ONLY.


This makes the Server the Permanent Gateway.

* To find out what your data directory is, click on Help=> About=> More About=>
   Environment from the Main DAT-MAIL menu.

If you don't want to run DAT-MAIL from the Server, (i.e. only the data is on the Server):

1. Go to a workstation and run the program.

2. With the program open edit the ~PVSW~.LOC file using Notepad in Windows.

3. Put in the Server machine Network Identifier -
   (This can be found under Start=> Settings => Control Panel=> System => Properties =>
   Computer Name).

4. Exit and Save the file in Notepad.

5. Make the ~PVSW~.LOC file Read Only by right-clicking, then click Properties and choose Read Only.

This makes the Server the Permanent Gateway.

Setting up the Server to be the Permanent Gateway

This does not have to be done on the server machine itself, since you are editing the .LOC
File to have the Server Name in it and then making it read-only. This makes the Server the
machine that always serves up the data. This process can be done from any machine with
access to the data on the server, since the .LOC file is located in the DAT-MAIL Statements
data folder which should be shared across all workstations.
**Note:** As of DAT-MAIL version 8.xx or higher with 2-5 users we require that you set up the Server as the Permanent Gateway.

For more detailed information on configuring a Gateway and its advantages go to: [http://www.goldstarsoftware.com/gateway.asp](http://www.goldstarsoftware.com/gateway.asp)

---

**Running the Workgroup Engine as a Windows Service**

We recommend installing the Workgoup Engine as a service, when choosing the Standalone or 2-5 user Network option (PSQL Workgroup). Choose this option during the PSQL installation.

**Note:** For 6 or more users on a network the Pervasive.SQL Client/Server installation with a 6-user (or higher) license will be required.

---

**Novell Network Users**

As a Microsoft Partner, Window Book follows Microsoft's time line for phasing out support for this O/S. We encourage all of our customers to plan and implement an upgrade to a supported Windows server in order to optimize the performance of their Window Book software.

Pervasive version 11 does not support Novell Networks.

For more detailed information and the specific dates on the support schedule, please visit [http://www.microsoft.com/ntserver/ProductInfo/Availability/Retiring.asp](http://www.microsoft.com/ntserver/ProductInfo/Availability/Retiring.asp)

---

**Installing Pervasive.SQL on Citrix**

**Supported Environments:**

You may install the Pervasive.SQL database engine in any of the following environments:

Win 7 / Win Vista / Win XP

Only one instance of the database engine may run on any terminal server platform. You cannot run separate copies of the database engine within two or more terminal sessions.
**Installation:**

To install Pervasive.SQL on a terminal server, you must be logged into the terminal server as a user with System Administrator rights.

Windows 2003 Server
Windows 2008 Server

Install Pervasive.SQL through Add New Programs

(Start=> Settings=> Control Panel =>Add/Remove Programs =>Add New Programs).

The operating system automatically handles the changing of terminal server modes.

---

**Tips:**

**Freezing, Lock Ups on Terminal Services**

The WBIinstall.ini file that our program creates on installation must be copied to the local system of each workstation that is accessing DAT-MAIL through Terminal Services. This file can be found in C:\Documents and Settings\Public Documents\Window Book (Windows XP) or C:\Users\Public\Documents\Window Book (Windows 7 and higher)
Pervasive SQL - Client/Server

Installing Pervasive.SQL Client/Server version for Windows: (6 or more users)

Pervasive.SQL Server for Windows must be installed on the server itself, as a choice during the initial Server installation of DAT-MAIL. You cannot install it remotely from a client machine. To install Pervasive.SQL Server on a Windows machine:

1. Launch the DAT-MAIL installation program. During the installation you will be prompted to install Pervasive SQL (if it does not already exist on the machine or if the existing PSQL version is less than version 10.30). Choose the Server option (if you plan to have six or more users of DAT-MAIL).

2. Click Next to proceed with the installation. During the installation a dialog will appear on which you can enter a license key. The license key is provided by Window Book Inc. Contact Window Book if you do not have a valid license key.

Note: It is all right to continue without a key, but you will need to get one immediately from your Window Book representative - there is no trial period with PSQL Client-Server licenses.

3. Type or paste the license key into the License field.

4. Click on the Setup Type desired: Complete or Custom (the default is Complete).

Note: "Complete Setup" is recommended. The Complete server installation installs the following components to your computer:

- Pervasive.SQL V11 engine (including ODBC interface)
- All client requesters (MS-DOS, Win32, and Linux Requesters)
- Utilities
- Transactional and Relational interfaces
- Client installation images
- Online documentation

5. Click Next.

6. Click Install to continue and then Finish to complete the installation.
After the installation is complete -- Registering and Testing

1. Registering your product:

If you would like to receive news about future updates, and other timely information, you may choose to register Pervasive SQL. You can also register later using a web, e-mail, or print-based registration form. When the product has been registered close the Registration page. The Pervasive System Analyzer (PSA) starts and allows you to test the transactional and relational interfaces. These tests ensure that your database engine is working as expected after installation.

2. Test the Transactional Engine. (See “Testing PSQL”)

Step 2 - Installing the Client Components on each workstation.

Installing the Pervasive.SQL Client Components (Windows)

Once you have completed the Server installation:

1. Run the DAT-MAIL full installation on each workstation. As long as you choose "workstation" during the installation as the "Install type" (and there is no existing PSQL instance on the workstation) the Installer will install the 32-bit PSQL client on each workstation. Note that the 32-bit client is necessary, even if you are running a 64-bit computer.

2. Click Next to proceed with the installation.

3. Click on "Complete" to choose the □Complete□ Setup. The Complete Client Installation installs the following components to the local machine:

* Transactional and relational interfaces
* Client requesters (DOS, Trace, and Win32 requesters)
* Utilities
* Online documentation

4. Click Next - A dialog will appear that informs you the installation program is ready to begin installing files. Click Install to continue.

5. If required, close any running applications that may interfere with the Pervasive.SQL installation. A dialog box will appear if applications are running that can interfere with the installation of Pervasive.SQL. Exit any program that may interfere, then click Next.

Note: "Next" will not proceed with the installation unless you exit all programs that may interfere.

Note: A reboot may be necessary at this point. Please reboot your system if prompted to do so in order to ensure proper operation of your Pervasive.SQL V11 product.
A dialog appears that shows the status of the installation process. Installation actions include, but are not limited to, the following:

* Script operations
* Component registration
* File copying
* Shortcut creation
* System registry updates

A dialog will appear at the end of a successful installation.

Click **Finish** to complete the installation.

**Note:** No PSQL license key is required on the workstations - the Server license is sufficient. Server licenses are 6-user, 10-user, 20-user or 50-user. Get the appropriate license key from Window Book Inc.
Testing PSQL

Testing the PSQL database using the Pervasive System Analyzer is not required but it is recommended in order to confirm that the Pervasive.SQL Database Engine is running properly.

To get to the Pervasive System Analyzer go to Windows Start=> Programs then choose "Pervasive System Analyzer" under "Utilities":

![Diagram showing how to access Pervasive System Analyzer](image)
1. Testing the network communications from the client machine to the machine running Pervasive.SQL Server

For the Target Machine, you must type the name or IP address of the machine running Pervasive.SQL Server. In the following example the machine name is "MachineA".

![Test Network Communication]

Specify a machine name or IP address where Pervasive.SQL engine is running as the target machine to test network communication.

Target machine:

MachineA

(Example: myservername or 192.221.253.2)

Click □ Next □ The communication test sends a series of test messages between the two machines. After all the messages are transmitted and received correctly, a dialog confirms that 75 messages were successfully transmitted. Click □ Next □ to continue.

2. Testing the Transactional Engine. PSA performs a series of tasks to ensure that the transactional engine is working properly.

**Transactional Engine Test**

- I do not want to run the transactional tests.
- I want to run the transactional tests.

Please select the samples directory on the server where your database engine is installed.

P:\PVS\samples

Please select the tests you would like to perform on the transactional engine.

- Create Data File
- Read Data File
- Update Data (write access required)
- Insert Data (write access required)

Click Next to run the tests and see the results.

**Note:** It is recommended that you perform this test to ensure that the transactional engine is communicating properly and the transactional databases are functional.

3. Run the Transactional Test

PSA displays a check mark for each test that passes and an X for each task that fails during the transactional engine test. A summary report is also provided in the information window, as shown in the following figure. Once your transactional engine tests are complete, click Next to test the relational engine.
4. Testing the Relational Engine.

PSA performs a series of tasks to ensure that the relational engine is working properly. Click **Next** to run the tests and see the results. **Note:** It is recommended that you perform this test to ensure that the relational engine is communicating properly and the relational databases are functional.

5. Run the Relational Test. PSA displays a check mark for each test that passes and an X for each task that fails during the relational engine test. A summary report is also provided in the information window, as shown in the following figure. **Relational Engine Test Results from PSA**

![Relational Engine Test Results](image)

6. After the relational engine tests complete, click **Finish** to exit the PSA test.
Defaults and Program Settings

DAT-MAIL Program Setups

DAT-MAIL Program Setups and Defaults

Program set ups are accessed from the "File" menu. A grouping of Setup Tabs will appear.
**Import Defaults Tab**

**Default Import Directory** - Press the **Default Import Directory** button and then select the path where you will be keeping your Mail.dat files. After you select the path, it will be displayed next to the button. Note that Mail.dat files can be imported from any directory, this is simply an option to go directly to the most commonly used path.

**Fast Network Option** - If you are using DAT-MAIL on a network and your default import directory (where new Mail.dat files are placed) is also on a network, you should check this option. When it is checked, the Mail.dat files you have chosen to import are AUTOMATICALLY copied to the temp directory of your local hard drive, then our indexed work file is created during the import process. When the import is done, the work file is copied back to the network and listed in DAT-MAIL's Mail.dat file list so anyone on the network can access it. Performing the disk-intensive import process locally is faster and doesn't slow down your network. No temp files will be stored on your local computer.

**Do Not Import Piece Detail File** - You can choose to not import the PDR file. This saves time during the import process and will not diminish the value of the data if you are not manifesting or tracking spoilage/shortage for 100% mailings.

**Park Piece Detail File** - In addition to 'Do Not Import Piece Detail File' there is an option to 'Park' that file. When the file is Parked, it will then be retrieved when you perform a PostalOne! release upload.

**Do Not Import Piece Barcode File** - You can choose to not import the PBC for similar reasons as with PDR. This file can be large and by not importing it, you can reduce the time it takes for the import.

**Park Piece Barcode File** - In addition to 'Do Not Import Piece Barcode File' there is an option to 'Park' that file. When the file is Parked, it is retrieved when you perform a PostalOne! release upload.

**Allow Changes to Data During Import** - Checking this box allows DAT-MAIL to make corrections to Mail.dat files as they are imported, which allows you to correct some common errors and make the Mail.dat file usable for production. If you are using DAT-MAIL specifically to test and troubleshoot Mail.dat files, un-checking this box will give you a complete report of all errors found without making any automatic repairs. Unless you are specifically troubleshooting files, we recommend that this option remains turned on.

**Set In-Home Date to Zero** - Your single file imports will automatically be stripped of the In-Home date that was preset in the Container Summary file (CSM) so that you may set this date at a later time. We suggest using our Mail Schedule View to set your mailing, shipping and in-home dates.

**Set Ship Date to Zero** - Your single file imports will automatically be stripped of the Mail Date that was preset in the Container Summary file (CSM) so that you may set this date at a later time. We suggest using our Mail Schedule View to set your mailing, shipping and in-home dates.
Delete Mother Pallets - This option will strip Mother Pallets that were created from the presort so you may perform your own Palletization in DAT-MAIL. Once you select this option, you can choose to delete which Mother Pallet levels you would like removed.

Run Batch Reports After Import - This great automation feature gives you access to batch reporting right after Mail.dat import. Review the Batch Report information in the section called "DAT-MAIL Reports" under "Reporting and Accounting". Set up your Batch Report profile then activate this feature.

Recalc Container Weights After Import - This is a handy option if you find that you are getting inaccurate tare weights from your presort which are skewing report information. There is an option at our Container Summary File View to run this process should you choose not to make this a default import option.

Run Freight Table After Import - Toolbox clients have the option to automatically run a freight plan using a predetermined freight table upon import. Editor clients have the option to run a Quick Plan upon import.

Run PMOD Export - This option will automatically export container information from your imported Mail.dat file that will be mailed via Open and Distribute.

Auto Export P1 Original File After Import - When this option is chosen, the program automatically creates a PostalOne! release file immediately after the import is completed which you can then submit to PostalOne! as your Original file submission. You will need to specify the export directory at our PostalOne! tab.

Create Sibling Records on Import - If we find container types marked as Logical, we will automatically create physical siblings for each of those Logical containers. You can specify which default sibling container type should be used at our Advanced Settings tab.

Mark CSM's Included in Other Docs - When chosen, we will update your Container records with a value of I (copalletization is done at the Originator's site) or O (copalletization is done at another site). Choose I or O at the PostalOne! tab.

Conformance Testing: Conformance Testing examines and analyzes your Mail.dat files in great depth to look for errors upon import - without a performance penalty. Also present is new error log format that is much easier to read and print. Use this valuable data to pinpoint and ultimately correct errors in your Mail.dat files.

We offer conformance testing at five levels:

Level 1: Referential Integrity testing only: no field level validation

Level 2: Field Checking: Required fields, proper data types in populated fields and referential integrity testing

Level 3: IDEAlliance Conformance testing: Adds checks for valid values in populated fields according to the specifications outlined by IDEAlliance.

Level 4: PostalOne!: Adds checks to the fields required by PostalOne! This is not
recommended for files you receive. Rather, this option is available for when you have imported a file and modified it to your needs. You can then export the file and re-import it using this validation level, so that you can determine if it will pass PostalOne! scrutiny.

Level 5: Special Circumstances: For future applications.

**Mark Container Status** - This setting defaults to "No Change" but you can alter it to "Preliminary" or "Blank". "Preliminary" is useful if you are required by PostalOne! to provide files that will create Preliminary postage statements when the file is uploaded. "Blank" is useful if your presort program consistently marks your Containers Statuses as "Ready To Pay" and you would prefer to have it blank.

---

**Daemon**

The Daemon is a means of automatically importing your Mail.dat files from a hot folder of your choice. You can choose different program setup options for the Daemon import behavior or you can choose to Sync Settings with the manual/single file import options. There are a few separate settings that are specifically for the Daemon:

**Run Entry Point** - Entry and Local Postage CSV Export - Select a directory where this CSV Export Report will automatically be exported to.

**Import SEL Files** - This option allows you to automatically import spoilage files from intelligent inserters.

**Delay for Daemon** - Sets a time delay default for automatic importing with the Daemon. **Tip** By default, this option should be set to zero, but for those customers who get the "please insert next disk" error when transferring zip files to the Daemon's inbox directory, the delay should be increased to 5 or 10 minutes.

**Daemon Skip Segments for Invalid Mail** - Enable this feature with the checkbox to set the number of segments to import. All other segments will be ignored. This can be a helpful feature if your files always have the same number of segments. For example, if you always mail two out of three segments, you could set this to "2" and the third segment would be ignored. The third segment could always be produced by your presort program for undeliverable or foreign mail pieces.
Mailer Information Tab

Enter all of your pertinent Mailer information including name, address, IDEAlliance Provider Code and DUNS here.

**DMU Verification Allow USPS Access to Maintenance Functions**  This option will allow the USPS terminal to run Internet Updates and other program maintenance functions. This is only recommended if they are using a standalone (local) copy of the DAT-MAIL program.

**TIP**! If they are connected to your live network program, leave this unchecked.
**Do Not Allow USPS to Import Mail.dat Files** - This option removes the import icon and File Menu options when the program is in DMU Mode. Check this option if your DMU clerk is using files on your network.

**Display Mail Sortation Reports for USPS** - This option provides access to the sortation reports from the "Reports" menu if the USPS is using DAT-MAIL to do verification and mail acceptance.
Planalyzer Tab

Planalyzer (Or Quick Plan) - Use this tab to set up default parameters for running dropship optimization on your files immediately after import via the "Run Freight Table after Import" checkbox on the "General" tab. If you have our Toolbox registration, you can check the "Use Planalyzer" box and choose a Freight Table to perform cost-based drop ship optimization.
PostalOne! Tab

- By checking this box, you open the program's ability to perform PostalOne! file exports for your eDoc submissions.

- Choose one of these radio buttons. If you do not plan on generating postage statements from your Mail.dat files and will only be participating in PostalOne!, then you should uncheck Generate Statements.
**Default PostalOne! Release Path** - Use this button to browse and select the path you want to place the Mail.dat release files generated by DAT-MAIL for uploading to PostalOne!. We can support all three USPS sites (PROD, TEM, CAT).

**Validate on Export** - This option is highly recommended. When your file is being exported for PostalOne!, we will run a validation process to determine if any errors exist prior to the export being finalized. When errors are found, you are given the option to halt the export process and fix said errors and then perform the PostalOne! file export afterward.

**Suppress Export of Original Release** - You can Suppress the export of an Original Release file to the PostalOne! website.

**Non-Automated Release Creation** - If you check this box, our PostalOne! file export process will display a window for you to double check the file header information that will be sent to PostalOne! and this gives you an opportunity to change it.

**PDR/PBC Export option** - If your Mail.dat files contain both a PDR and a PBC file, you must choose which one you will be sending to PostalOne!.

**Tray based co-palletization default value for CSM Included in Other Documentation** - choose either I or O, the default is O. This value will be used during any CoPal processing in the program.

**Tip!** Review our supplemental guide titled PostalOne!, FAST and Detached Mail Unit Verification User's Guide for detailed information regarding the setup, activation and use of PostalOne! through DAT-MAIL.
**Startup Options Tab**

**Job Options** - The list of Jobs that are imported into the program can be sorted by one of these selections.

**Entry Point Display and Print Order** - choose either by ZIP Code or by Production Seq.

**Start Up View Options** - After a Mail.dat file is imported, you can choose a default View that the program will display for you. The default is the "Navigator" view.

**Restrict Job Selection by Revision No.** - If you tend to import the same Job multiple
times due to changes in presort processing, you can choose to activate this option which will allow only the latest file revision to be selected for editing.

---

**Statement Generation Tab**

![Statement Generation Tab Image]

- **Client:** CLIENT
- **Permit:** 1
- **Address:** Boston MA 02114
- **Generate Statements by:** Entry Zip, Delivery Zip
- **Applied Method:** Neither
- **Applied Rate:** 0.0000
- **Carrier:**
- **Automatic Client Identification:** Not Activated, First Characters of File Name, First Characters of Original Job ID, Characters of Header User Option Info
- **Automatic Job Identification:**
  - Start Pos: 0
  - Length:
    - Job: 0
    - SubJob: 0
    - Lot: 0

[Image of the Statement Generation Tab]
**Client/Permit** - Enter defaults for Automatic Statement Generation. The default Client will be used during automatic statement generation in conjunction with our Daemon or single file import process if the option to 'Generate Statements Automatically at Import' has been activated.

**Optional Procedure** - Check this box if the bulk of your mailings are verified under an Optional Procedure agreement. At the time your statements are to be generated, you can choose to uncheck the Optional Procedure box if the mailing is not part of your OP agreement.

**Generate 8125/8017** - Recommended if you will be generating postage statements for destination drop ship entry points. An 8125 or 8017 will be created automatically from your statements.

**Drop Ship** - This controls whether or not a Consolidated statement will be generated for your drop ship mailings. This setting can be overridden at the time of statement generation from a single file import or through automatic statement generation from a single file import. This setting is ignored by our Daemon which uses a different technique to automatically detect dropship from non-dropship files.

**Update Container Grouping-ID to Zip Ref** - The update Container Grouping-ID to Zip-Ref will update your Group 1 Batch Code or Postalsoft Entry Point Number to the Zip Reference field of the statement. When you print a 3602-RV, the Zip-Reference number can print in each statement section.

**Generate Statements Automatically on Import** - This turns on the feature that allows you to generate statements automatically after the Mail.dat import is complete. This feature can be used when you do NOT need to make any changes to your Mail.dat file in relation to entry facility.

**Set Import Date and In-Home Delivery Date to 0** - If you are generating your statements automatically upon import and do not want them to have either mail dates or in-home dates, enable this option. When statements are created, the rate table used will be based on your computer's system date. When the mailing actually takes place you can change the postage statement's date. This way it is easy to tell the difference between statements for mailings still in production vs. statements that have actually mailed. If you are registered for DAT-MAIL PostalOne! Web Services, you will also see a checkbox.

**Run POWS Qualification Report before Statement Generate** - **Note:** This is an obsolete setting and will be removed.

**Applied Postage Information** - These defaults will be used if you are creating a statement with affixed postage but can be changed if you are not using the Automatic Statement Generation feature.

**Applied Method:** If you select Neither, you can enter the applied rate. This rate should be equal or lower than the lowest postage rate being mailed. **Lowest** - This automatically applies the postage for each entry point at the lowest postage rate used by each entry point. If not all entry points are being mailed at the same rates and you are applying the postage at the same rate for all entry points, it is best to select Neither and enter that rate. **Correct** automatically applies the correct postage.
Balance Paid By: If you have applied the postage at a "Neither" or "Lowest" Rate, there will be postage due for the mailing. You must select a payment method for this balance. If you select "Permit" or "Trust", you must also select the permit/trust account that is being used.

Permit: If the balance is paid by permit, select this option and select a permit. According to DMM regulations you must also create a 3600-R, 3602-R or 3602-N for this additional postage. If you do not do this and are using the Postage Accounting program, this postage usage will not be allocated to the job. If you do not create these extra statements, then you are really using your permit as a trust account and should choose "Trust" instead.

Trust: Selecting "Trust" still requires you to select a permit but you do NOT have to create an additional postage statement for the balance due.

Meter: If you are applying a meter strip on the postage statement to pay for the balance due, select "Meter".

Stamps: If you are applying stamps on the postage statement to pay for the balance due, select "Stamps".

Check: If you have an arrangement where you are directly paying the balance due by check, select this option. If you are expecting a value added refund however, this will be the selection to make since the overpayment is not applied to a permit or trust account.

Automatic Client Job and Mailing Agent Identification Options
When activated these options are used with automatic statement generation during the Mail.dat file import (using the ImportDaemon or during a single file import).

Automatic Client Identification
Radio Button Choices:
"Not Activated" (Default) turns the option off. When any of the other three radio button options are selected the feature is considered ON and parses the Client code from the three possible sources (File Name, original job id, or hdr:UserOption).

"First Characters of File Name" (must enter end position) - this is the name of the Mail.dat file set itself (i.e. datjob.hdr)

"First Characters of Original Job ID" (Job Number) (must enter end position) - can be used in conjunction with Job Parsing "Characters of Header User Option Info" (must enter Start and
End Pos.) - most presort programs will allow information to be entered into the header for use with this option.

**Automatic Mailing Agent Information** - When ON, during Mail.dat file import the company will be derived from the VerificationFacility Zip found in the first Segment record. This zip is compared against all zips in your Mailing Agent file and if a match is found then that company is the one used during statement generation.

**Automatic Job Identification** - DAT-MAIL has statement generation options which can create separate statements for each Job, Version (lot) and payment type (Permit, Meter and Stamps) and tie them to a single consolidated statement for each payment type that can serve as a commingled statement.

To setup the parsing, you must define how the MPU Description is parsed under Automatic Job Identification. Enter the info on the Job, Hagen SubJob (Hagen users only) and the Lot (usually referred to by mailers as package, copy or version). If the mailer is not adding a SubJob to the Job, this can be left empty. When we import this information, the SubJob is added to the end of the Job number and the two are separated with a dash. For instance: Job 1234 / SubJob 001 / Version 001 will be represented as **Job 1234-001-001**.

The parsing information to enter looks like this:

**Job:** Start 1, Length 4
**SubJob:** Start 5, Length 3
**Version:** Start 9, Length 3
Container Tare Weights Tab

Container Tare Weights - Most all of our reports include the Gross Weight of your containers. We have provided some default values which you may override here.
Build Floating Batch Manifest View – If you are a manifest mailer, check this option to build the floating batch manifest during your file import. The “PDR” file must be populated with piece ids by your presort program. You also have an option to sort this information ‘by Segment’.

Print Delivery Point Barcodes instead of Piece IDs - (This feature is no longer used and will be removed).

Change Single Piece Rate for First Class non-Presort – When activated, the program interrogates the Mail.dat file that is being imported and if it finds that all of the mail is Single Piece rate, it updates the related MPU and sets the Rate Schedule Type value to "Retail”.

Send Non-Qualifying Containers to Verification Facility (Standard Mail only) – During import, when active, this option will detect ‘S’ rate categories in STD Mail files and change their entry point(s) to that of the related segment record’s verification facility zip.
FULL JOB PARSING SUPPORT!

Here is what you will have access to:

Job Parsing allows mailers to use a convention of combining Job # and Lot/String/panel into a Job ID. DAT-MAIL will then parse this information when we generate statements so that the job number and lot get populated correctly and automatically. For example, you may have 5 Mail.dat files for the same job, one for each "lot" in the job. If the Job no. was 5 characters and the lot was 3, you would set the parsing so that the first 5 characters of the Job ID read Job and the next 3 read Lot.

Populate blank container grouping from Segment Description – In conjunction with Job Parsing, if your presort program does not populate the Container Group ID field in your container file, you can enable us to do it using a specified start/end position from your Segment Description information. The maximum character length of the Container Group ID is nine.

Auto Generate Sibling – In conjunction with the setup option box on the Import Defaults tab to 'Create Sibling Records on Import', you can specify additional default options. Select a default container type for your trays/pallets. Choose which type of import (manual or daemon or both) should create sibling records. Also, choose whether or not these sibling records should be deleted when the file is exported and specify which type of export.
Drop Export Settings:
If you plan to generate files describing each 'drop' being made in a job, you can enter the starting drop number here. In the Mail Schedule View you can now identify which dates each entry point or entry point/segment combination will be mailed. An export button will create CSV tab delimited or an XML file which will include all information needed by a work ticket and setup a 'drop' for each entry point for each mailing date.

Use the "Export CSV" to export a tab-delimited file with columns for:
Job Number, Package, Drop ID, Mail Date, First In Home Date, Last In Home Date, Piece Weight, Mail Class, Processing Category, Non-Standard Flag, Non-Profit Flag, Permit Number,
Activate Open and Distribute Exports - This feature is used in conjunction with Window Book's Postal Package Partner program. DAT-MAIL subscribers can open their Mail.dat files, go to the Mail Schedule View, tag the entry facilities for which they wish to create Priority drop ship labels and export them at the click of a button. Window Book's Postal Package Partner (PPP) program can then import the Priority Mail drop ship data in a few mouse clicks, allowing users to tag these records and print their labels in batch mode. This PPP feature enables the industry-leading postal mailing and shipping software systems to work together, creating a more streamlined overall system for mailers and shippers who are eager to process Priority Mail drop shipments more quickly and efficiently.

Mail.dat Export Settings:

Export physical zips as Locale Codes - This feature will populate the physical zip fields in the .CSM file with locale codes upon export for non-PostalOne! exports. PostalOne! exports are now required (as of 8/14/2006) to export locale code and the export process will do so regardless of this new option. The locale code is the facility site code of the destination minus the first digit. For example, the facility site code for SCF HARTFORD CT 060 is EV20284 and the locale code is V20284.

Auto-calculate CSM gross weight - This option will automatically recalculate the gross weights in your files upon import using the container tare weights you have defined.

Export using Historical JobID - You can choose to keep your originally supplied Job ID in your Mail.dat file when they are exported instead of using DAT-MAIL's Job ID that is uniquely assigned each time a file is imported.

Update Sibling Container Mailing Field (SEG-1117) on Export - This setting should be used if you encounter PostalOne! validation errors where the Sibling fields are expected to be populated.

Do Not Export UPA - This option will suppress your UPA file (if supplied) from being exported when you perform a Regular or PostalOne! file export.

Export mail.dat to compressed file - This option will zip your Mail.dat file when you perform a Regular or PostalOne! file export.

Export to version - There are times when a Mail.dat specification is in transition and you may prefer to keep exporting the prior version rather than using the newest supported version.

Create OCI - You can choose to have the optional OCI file created and included in your Regular or PostalOne! file exports.

Use Alpha/Numeric File Naming Convention - This option will ensure that your PostalOne! file names are unique for a much longer period of time. This is often used by mailers who submit thousands of files to PostalOne! in a given year.
**Spoilage P1! Export Default** - The recommended settings for PostalOne! would be to choose either W or S.

**Archive Settings:**
Allows you to select and set an Archive Default Directory as well as the parameters for archiving by date. A checkbox allows you to force USPS approval before Archiving any Mail.dat files.

Archiving is essential for two reasons...

1. It keeps your Job List from being overpopulated with mailings that are completed.
2. If you are mailing under an Optional Procedure agreement, you are required to retain your job information for at least a period of one year.

When you choose to archive, DAT-MAIL automatically puts your file into a zipped format to reduce the space requirement.

**Using a a Command Line to Semi-Automate:**

The Mail.dat archiving utility can be run from a command line. MDARC.EXE can be followed by /A=<No. of days> and /D=<folder to put the archive files>. When it is launched with these command lines, there the screen displays an archive time. You set it to a specific time (ie. 2:00 am) then start the archive, then minimize. Every day at the allotted time it will archive all Mail.dat files over the number of days specified with /A= and place the archive files in the folder specified by /D=.
Enable Pallet Tracking - This feature automatically activates "Generate Unique ID’s for Pallets" when selected. All uniquely numbered Pallets will be added to our pallet tracking database. **Note:** This is a critical setting if you are using the D.I.M.E. interface for RR Donnelley.

For Mailers participating in Intelligent Mail Container Labeling:

- **Participate in Intelligent Mail barcodes** - By activating this setting, our program will either assign unique IM codes or log your unique IM codes.

- **Overwrite Pallet Label 24 Char barcodes** - Choose this option if you would like the program to generate your unique IMCL codes.

- **Overwrite Tray/Sack Label 24 Char barcodes** - Choose this option if you like the program to generate your unique IMTL codes.
**IMB Numbering:**

**Assign or Log at Import** - Choose this option if you would like the program to create or log your unique IMTL/IMCL codes when your files are imported.

**Assign or Log at Tag Printing** - Choose this option if you would like the program to create or log your unique IMTL/IMCL codes when you are printing Tags/Pallet Placards.

| Tip! | IMTL/IMCL codes will **only** be created if you have the 'overwrite' options selected. |

**Register IM Piece Barcodes** - Activate this option if you would like the program to write your unique IM Piece Barcodes to our MS SQL database. When the IM Piece Barcodes are in the MS SQL database, we can query that table when you want to apply spoils/shorts.
The settings shown here are helpful to Window Book's Support Technicians and should not be changed.
Statements Setup

DAT-MAIL Statements can be generated in two ways:

1. Statements can be generated from a Mail.dat file.
2. Statements can be generated via data entry, without the need for a Mail.dat file.

Access Statements via the 3602 Icon on the toolbar or via the Utilities => Print Statements menu. To access your DAT-MAIL Statements Set Up Tabs, open the DAT-MAIL Statements section of the program by clicking on the 3602 icon or via the Utilities Menu as described above. Click on File=> Program Set Up.

General Info

If you do not see the OK, Cancel, and Help buttons, try positioning the box as far into the upper left hand corner of the program window as possible. (You can click on the Window=>Tile menu to accomplish this). If you still cannot see these buttons, check your screen resolution which must be at least 800 x 600.

Use Quick Date Entry - when this is checked you can type in an abbreviated date - mmddyy would bring in current month/day/year - for instance 051213 would display as May 12, 2013.
**Auto Number Client Records** - when this is checked, the unique client codes will be assigned automatically. If not, the user must assign a unique client code for each client entered.

**Lookup Clients by Code** - normally DAT-MAIL will allow client look-up by the first few letters of the client's name when creating Statements. If you prefer to use the client code instead, check this box.

**Limit Piece Counts to Master Statement Quantities** - if the user is working from a Master Statement, he/she will be prevented from entering a mailing quantity for any rate greater than the balance in the Master Statement. If this option is not checked the user will be warned but will be able to over-mail the rate.

**Create Postage for 3606 Receipt** - if this box is checked the default setting for the "Create Postage Entry" checkbox in the 3606 program will be checked. This includes the 3606 postage in all reports in addition to the service charges.

**Clear Check Request After Report** - After running your Check Request report, the statements that have already been included will be dismissed from the next Check Report that you run - helpful if you need to run the report more than once a day.

**Do Not Verify User 1** - When DAT-MAIL creates statements, it updates the last client, permit, job description back to the job file, the permit gets updated as the default permit to the client file. This is a great feature for mail owners who don't want their master files altered by creating statements.

**Protect Job and Client File** - by checking this option in program setup, the program will not update your Job File with the client and permit information in your "new postage statement".

**Example:** If you create a postage statement for Job ABC and select Client 123 with Permit 456 we are not going to "hard code" this into your Job File for Job ABC - so Job ABC will not be associated with one particular client and permit number. Also client 123 will **NOT** be associated with only Permit 456.

**Entry or editing of this data:**

**Enable Non-identical Mailing Verification** - Our program has two weight verification systems. One (the default) requires identical piece weight and the other works with Non-Identical weights. With the non-identical option turned on, the program adjusts pound postage on pound rate mailings based on actual mail weights. You enter the weight of each pallet in the mailing, then our system subtracts the tares and compares the mail weight for the physical pallets with the weight in the statement. If it is different, the pound postage is adjusted in the STD mailing.

**Do Not Preview Any Reports** - if this is checked, all reports print directly to the printer. If it is not checked, the user is prompted to preview the report first, after which the report can be sent to the printer.
External Data Settings

**ODBC Connect** - If you have purchased the optional ODBC Connect module, choose your external database here to bring in data for creating postage statements. Please reference the “ODBC Connect” section for complete details. Other External Data options are also available, contact your sales representative for more information.

**More Optional Modules...**

*Connect to your BCC Mail Manager, Printstream or Pro-Mail data*
Statement Defaults

Rates Lookup Statement Date - if the mailing date is left blank, this date is used to pick the correct rate table. It should be changed whenever a new rate table takes effect.

Default Mailing Agent - enter the mailer code that will be the default applied on your statements.

Mail Under Optional Procedure - If your company participates in the USPS Optional Procedure Program, check this checkbox. You will be able to indicate whether each Statement is mailed under Optional Procedure and all "OP" Statements will appear on the OPTIONAL PROCEDURE REPORTS available in the Daily Reports menu. Currently, this is an ALL or NOTHING setting box. If you have certain statements that you do NOT want mailed under Optional Procedure you will have the option at the time you create your statements to uncheck' the box.

TIP: When 'Mail Under Optional Procedure' is activated, the program automatically sets the Sequencing Auto Numbering scheme to Permit No. and Receipt Auto-Numbering to Control No.

Include Meter and Stamps in the Op Report - If you would like your Meter and Stamp mailing statements to also be included in the Optional Procedure reporting, check this box.
**Lot Required** - If you want to force the Lot to be added when statements are entered.

**Add Sequence Number to CAPS ID** - Will help aid in tracking CAPS accounts.

**Do Not Populate Default Mailer and Permit** - Allowing for blank, last minute hand entry.

**Default Move Update Method** - Choose from available options. This value will be used if there is not a Default Move Update Method identified in the Client record being used for the postage statement.

**Limit Piece Counts to Job File** - If you enter a number of pieces in a Job record that should be mailed and you check this box, you will not be able to create a statement for over that amount.

**Do not auto-populate Form Type on Misc. Statements** - By checking this box, you will prevent the system from assigning the Form Type value from an existing Job record into a Miscellaneous Statement.

**Default Statement Form** - This default allows you to select the statement that you use most often as a default.

**Default Statement Listing Order** - This default lets you choose the default sequence in which you will see your Statements. Press the radio button for the desired choice: Control Number, Permit Number, Client, Job or Receipt.

**Default First Class Weight Type (Pounds or Ounces)** - default unit of measure of piece weight when creating First Class Statements

**Default Std(A) Weight Type (Pounds or Ounces)** - default unit of measure of piece weight when creating Standard (A) Statements

**Default Rate Tree on Statement Add (Normal, Expand All, Contract All)**

*Normal* - shows all available parts and entry discounts with no rates. You would expand only the tree sections that contain the rates at which you are mailing. This way all the rates you are mailing may be visible on the screen without any scrolling.

*Expand All* - Shows all parts, entry discounts and rates. You would scroll down to each rate you are mailing and enter your piece counts. For Standard mail, you would most likely have to scroll down the screen to get to all of your rates.

*Contract All* - Shows only the available parts for each Statement. You would expand both the parts and the entry discounts to get to the rates. This will display the smallest amount of information needed to enter the piece counts.

**Sequence Auto-Numbering** - Choose the method you wish to use to automatically assign the Mailing Sequence Number of each Statement. You may elect not to auto-number your Mailing Sequence number but DAT-MAIL Statements can auto-number this number three different ways.
1. It can assign the Mailing Statement's Control Number
2. It can use the "Permit Control" number or
3. It can use the job number.

Each time a mailing is made with a permit, the permit control number is incremented. For example, if you are doing three Mailing Statements on permit number 100, the permit sequence numbers could be 100-341, 100-342 and 100-343. If you are Mailing under Optional Procedure, two separate Permit Sequence numbers are supported, one for mailings made under Optional Procedure and one for mailings not done under Optional Procedure.

This is why the Permit Control number is the preferred Sequence Numbering method if the mailer is mailing under Optional Procedure. The Job Control number takes up to eight characters of the job number and adds a dash followed by a number. If you do five Statements for job 1542, the Job Control numbers will be 1542-1, 1542-2, 1543-3, 1542-4 and 1542-5.

**Receipt Auto-Numbering** - You can assign no number the Receipt Number field or assign the control number, permit sequence number or a Year/Week code. The Year/Week code prints the year followed by your fiscal week number based on the fiscal year begin date that you can enter if this numbering method is used. The Job Control number can also be used as described above.

**Tip!** We highly recommend that either the Receipt Number or Mailing Sequence Number be assigned to the Control Number! This makes it easier to locate your Mailing Statements in the program.
Statement Print Settings

Default Statement Copies - The number of Statement Copies you normally print

Print Employee Name - If an employee code is entered, the employee's name is printed in the Statement in the signature block.

Print Employee Initials - If checked, the employee initials print on the bottom of the Statement.

Print Client Code On Statement - If checked, the code used for each Client will print on the statement. The printed code will appear in the Client Information box at the upper right-hand corner of the statement in a small font.

Printing Adjustments - Use these settings to customize your printing of statements as needed.

Enhanced Statement Printing - We are transitioning our printed statements to use a .NET technology for enhanced printing methods. Soon, these boxes will be removed and will become the default.

Create PDF version of Statement when Printing - During statement printing, a copy of the statement will be printed to a .PDF and stored in user-defined directories.
Periodicals

These defaults are designed to assist the mailer with weighing sample pieces to assure six-digit accuracy. Most postage scales are not capable of this level of accuracy without a sample that includes multiple copies. If the accuracy of the scale is known (it is usually rated on the specification page in the scale's user's guide), it can be entered here. When a Periodicals Statement is created, the number of copies that are needed in the sample to achieve six-digit accuracy will be displayed after the weight of a single copy is entered. If the number of copies weighed in the first sample is not as many as suggested, we recommend re-weighing using at least the number of copies suggested.

Include Pieces when Copying Periodicals - If this checkbox is checked, the piece counts of the highlighted Statement will be copied to the new Statement when the Copy button is pressed. This is useful for mailers that do not update their subscription list very often.

Scale Accuracy - Enter the accuracy of the scale as rated in the scale user's guide.

Scale Accuracy Type - Select whether the scale's accuracy rating is in pounds or ounces.

Maximum Weight - Enter the maximum weight that can be handled by the scale.

Maximum Weight Type - Enter whether the maximum weight is rated in pounds or ounces.
Drop Ship

Summary Format - The normal V summary is the short summary which breaks out the rates by rate category combining mail for all destinations. The long summary separates and subtotals by destination. The Job/Lot summary sorts and subtotals the mailing by job and lot if mixed jobs and lots are being mailed on a single PV (this can only be done by tagging regular 3602's).

Print in PV Mail Detail - The beginning of each 3602 section of a "3602-V" form contains enough space for only 2 out of the 3 possible entry fields a mailer may wish to print. You can choose the combination of fields to be printed - Package & Control Number (Used if Marriage Mailings are being made) Package/Lot (Used if Marriage Mailings are being made or are mixing lots) Job/Lot (Used if you are mixing Jobs and Lots on 3602-V's)

Print Summary Totals - The totals on the summary page are from the unrounded postage totals on the summary section and do not match the totals on page one of the PV which is the only "official" postage total. Some Post Offices wish to see this total but we DO NOT RECOMMEND checking this box and providing it to your Post Office. It is an indication that they are incorrectly entering the postage totals in the USPS Postage System. If you are using the Permit Balance Tracking program or Lettershop Postage Accounting, the use of this postage figure by the USPS will cause the permit balances maintained by the USPS and DATMAIL or Lettershop Postage Accounting not to match.

Add Pallets to Container Totals - When printing container totals, you can suppress the printing of pallet counts on the V forms. If you are mailing 120 trays on three pallets you can report this as 120 trays on 3 pallets OR just 120 trays if this checkbox is unchecked.
**Consolidate Permit Activity** - If this checkbox is checked, any report that prints by permit number will consolidate all of the entries for a PV into a single entry. If you mail a 29 destination PV and this box is not checked, you will see 29 separate entries on the permit reports. If the box is checked, you will see a single entry for the PV. This makes these reports easier to read.

**Print "Partial" Consolidated Statements (Commingled)** - You will be prompted to choose from a selection of Clients, Jobs and Lots for the Consolidated statement being printed.

**Sort Destinations By Physical ZIP (3602-C)** - When this box is checked, we will print the Destinations on the 3602-C form in Physical ZIP code order.

---

**8125 Settings**

*Always Create 8125* - Toggle checkmark on and off as desired. This controls whether or not you want our system to automatically create a corresponding 8125 when you have manually entered a drop ship postage statement.
Fill in 8125 Section 2 - Section 2 is supposed to be filled in by the USPS but many Bulk Mail Acceptance personnel prefer the mailer to fill in this section. Check this box if you want the statement information pulled into this section.

Contains Mailing Pieces for Outside Delivery Area - Checks the appropriate box in Box 14, "Mailer Information".

Default Format - DAT-MAIL supports two different 8125 formats - (1) Regular 8125's and (2) consolidated 8125’s. Consolidated 8125's prints out all the mailings in a list format.

Default Origin - Indicate what the usual origin of your mail is - Mailing Plant or Post Office.

Mailing Agent Code - Enter the default Mailer ID that you want to print on your 8125's. This value will be used unless the statement has a different Mailing Agent assigned to it.

Appointment Number - Leave this blank unless you have a standing appointment number with your Detached Mail Unit or Post Office.

Default values used when not defined in Mailing Agent Record USPS Employee Information - To print as a default in Origin Post Office Section 2 PRINTS BOX 26a (Std A)

USPS Phone - PRINTS BOX 26b (Std A)

Mailer Contact Information - PRINTS IN BOX 5 and 6 (Std A)

Use Employee from Statement - When this box is checked, the default Mailer Contact information will not be used. We will use the Employee value that is entered on the postage statement.

Default Carrier Information - PRINTS IN BOX 16a and 16b (Std A) if Carrier Makes Drop Ship Appointments box is checked.

Default Comments - PRINTS in Comments Section of 8125 - if you cannot access default comments here, go to the 8125 Printing set up and select Pint 8125 Comments as entered.
8125 Print Settings

Do Not Print 8125 Ship Add - Check this box if you do not want the address of the BMC/SCF/DDU facility to print on the 8125.

Do Not Print Gross Weight - Check this off if you do NOT want DAT-MAIL to print a gross weight figure on the 8125 form.

Do Not Print Container Count - Check this off if you do NOT want DAT-MAIL to print container counts on the 8125.

Print 8125 Comments - The 8125 contains several comment lines which can be automatically filled out. The way this is done is controlled by your selection.

As Entered - All comment information must be added by editing the 8125. If you want a constant comment to print on every 8125 that you generate, you can select this option and then enter the Default Comments on the right side of this screen.

Add Jobs - When this option is checked, the Job numbers from the statements that are associated with your 8125 will be listed in the comments section.

Statement Comments - we will use the comments you entered from the Statement that generated the 8125.

List Pallet Numbers - This option will print individual or a range of pallet numbers pulled from the Container information on the Mail.dat file used.
Pallet Barcode Numbers - This option will print the Unique Pallet Barcode number assigned from the Mail.dat file.

8125 Printer Button - Access to set a unique default printer for 8125s.

8125 Copies - default number of copies printed

Disable Printing of Tray/Sack Counts - When checked, we will not display the number of trays/sacks that are included on a Pallet.

Print USPS Postage Statement ID - If you are using our Window Book Automation Scheduler to run the USPS MDR Client in batch mode for uploading your eDocs to PostalOne!, we can retrieve the USPS Postage Statement ID through the XML Receipts that are returned to us and have it print on your related postage statement.

8017

Allow Creation of 8017 - Toggle checkmark on and off as desired. This controls whether or not you want our system to automatically create a corresponding 8125 when you have manually entered a drop ship postage statement.

Always Create 8017 - Toggle checkmark on and off as desired. This controls whether or
not you want our system to automatically create a corresponding 8017 form when you have manually entered an Origin destination entry postage statement.

**Do Not Print Gross Weight** - Check this box if you do NOT want DAT-MAIL to print a gross weight figure on the 8017 form.

**Do Not Print Tray/Sack Counts** - Check this box if you do not want us to print the number of trays/sacks that are included on a Pallet.

**Print 8017 Comments** - The 8125 contains several comment lines which can be automatically filled out. The way this is done is controlled by your selection.

**As Entered** - All comment information must be added by editing the 8017. If you want a constant comment to print on every 8017 that you generate, you can select this option and then enter the Default Comments on the right side of this screen.

**Add Jobs** - When this option is checked, the Job numbers from the statements that are associated with your 8017 will be listed in the comments section.

**Statement Comments** - we will use the comments you entered from the Statement that generated the 8017.

**List Pallet Numbers** - This option will print individual or a range of pallet numbers pulled from the Container information on the Mail.dat file used.

**Pallet Barcode Numbers** - This option will print the Unique Pallet Barcode number assigned from the Mail.dat file.

**DMU Destination Office** - Enter your local DMU Post Office information so it will print on the 8017 form.

**8017 Printer Button** - Access to set a unique default printer for 8125s.

**8017 Copies** - default number of copies printed
Bill of Lading

Mailing Agent - Select the default mailer code for the bills of lading. This mailer name and address will be printed on the Bill of Lading automatically unless over-ridden.

Default Copies - the number of copies to print of the Bill of Lading.

Prepaid - If freight is always prepaid (vs. collect), check this checkbox.
**User Defaults**

DAT-MAIL Statements has six user-defined fields which you can name yourself. Data entered in these fields can be included in reports created with a third party Report Writer or the optional report writer that is available for DAT-MAIL Statements.

In the "User Default" screen, you can name the fields and create a "Hot Key" by placing an ampersand (&) in front of the letter you wish to make "hot". Please avoid using the letters O, H and C since they are already assigned to the OK, Help and Cancel buttons. You do not have to either assign hot keys or use the first letter of a title.
User Prompts

Check the "Maintain Extended User Information" checkbox to access these controls.
Customize statement entry with User Prompts.
Export

Enable MailOwner Statement Export - check this box in order to Export your statement data to your clients (Mail Owners).

Jobshop Statement Export - can be used with Mail-Shop, ProMail or other compatible JobShop program.

Use USER5 for Mail Owner's Job Number - this option substitutes the Mail Owner's own job number for your job number during the export if you use 'User 5' for the Mail Owner's job number.

Export Only Verified Statements - when checked, this will only export statements you have 'Verified' by marking with the blue checkmark icon on the statement browse toolbar. This has two benefits: It gives you control over what gets exported and it allows you to confirm that the postage for the statement is correct before you provide that information to your customers.

Do Not Export Statements where Piece Type = OSF - This is a recommended setting when using Pro-Mail.

XML Reports - You have the option to select All or Some of our postage statement reports that you’d like exported in an XML format. An additional option will appear on the Report generation windows.
**TIP!** The following setting selections are all Optional, and will not appear unless your program has a registration code that includes them.

**Accounting (optional module)**

![System Setup Window](image)

**Default Invoice Type** - These options are only recognized if your program is registered for our optional Postage Accounting module.
Confirm (optional module)

The Confirm tab only appears if you are Registered for Confirm / Entry Information / TrackMyMail.com. Click the button to access the Confirm / Entry Information/TrackMyMail.com User Guide documentation.
FAST (Optional, only activated for FAST Users)

This option only appears if you have a registration for DAT-MAIL that includes FAST. The option gives you access for entering the required participation information as shown.
PostalOne! (Optional, for PostalOne! Participants)

The PostalOne! option only appears if you have a DAT-MAIL Registration that includes PostalOne!. This gives you access to your PostalOne! Login and Permit Info.
Mail.dat File Import

Conformance Test Engine (CTE) Validation

CTE (Conformance Test Engine) Mail.dat File Validation

Conformance Testing examines and analyzes your Mail.dat files in great depth to look for errors upon import -- without a performance penalty. Also present is new error log format that is much easier to read and print. Use this valuable data to pinpoint and ultimately correct errors in your Mail.dat files.

We offer conformance testing at five levels:

Level 1: Referential Integrity testing only - no field level validation

Level 2: Field Checking: Required fields, proper data types in populated fields and referential integrity testing

Level 3: IDEAlliance Conformance testing. Adds checks for valid values in populated fields to the specifications set by IDEAlliance, the organization which sets and maintains the Mail.dat specifications. See www.IDEAlliance.org for more information.

Level 4: PostalOne! Adds checks to the fields required by PostalOne!

Level 5: Special Circumstances: For future applications.

Conformance Testing Tab

(accessed from DAT-MAIL Program Set Up)

Set a default for Conformance Testing here. This default can be overridden at each individual import if so desired.
**Allow changes to data during import** - Check this box to allow DAT-MAIL to make corrections to Mail.dat files as they are imported, so you can correct some common errors and make the Mail.dat file usable for production. If you are using DAT-MAIL specifically to test and troubleshoot Mail.dat files, unchecking this box will give you a complete report of all errors found without making any automatic repairs.
You are able to override the Program Setup default at each individual import using the drop-down box as displayed in the illustration above.
After a File has been Imported

When you go to open a previously imported Mail.dat file. This is the View you will see. The indicators along the left hand side and the View Import Status button are elements relating to Conformance Testing:

- **The Blue Checkmark**—indicates that your Mail.dat file has passed the level of Conformance Testing selected.

- **The Yellow Exclamation**—indicates that a non-critical error (such as file name) has been detected.

- **The Red X**—indicates that a more serious error (such as a required field not filled in) has been detected.

By clicking on the View Import Status button, you will bring up a detailed, printable report outlining any detected errors. The report can be viewed by Sequence or Field, and contains the following data: Sequence, Record, Field, Error Number (see chart.)
below), Error Count, Message (a description of the error), Field Value, Bad Value, and the Key Fields.

Error Key

111 - Either a required file is not present, or a required file is present but does not have valid data

112 - File name is not valid

113 - File name is not unique

121 - A stand-alone record is missing from the file

122 - A connected record is missing.

123 - A 'parent' record is missing children. For example, you could have a segment (parent) which has no container records as part of the segment.

124 - A child record with a missing parent. A good example would be a record in the Container Summary file which has the "Parent Container Reference ID" pointing to a 'mother pallet' which does not exist.

131 - Missing Provider Code

132 - Missing required values in Key Fields

211 - A field value that is always required is missing

212 - A field value that is sometimes required is missing (usually subject to mail class and processing category)

213 - A field value that is not required has an invalid value. If an optional field is populated, we will check the value to be sure it is acceptable according to the IDEAlliance specifications.
Single Mail.dat Imports

From the main menu press the second icon from the left, . If you point to the icon with your mouse pointer, a tip box will say "Import New Mail.dat file". You can also go to the File Menu and select "New Mail.dat Import" from the menu.

Press the Select Mail.dat File button and select the Mail.dat file you wish to import. It can have either a "ZIP" or "HDR" extension. If it is a zipped file, after you select the file, it will be automatically unzipped and you will see the "HDR" extension appear in the File Select dialog.

The Job ID and Description will automatically appear on the screen. You may overwrite them with different information.
If no estimated mail date, in-home delivery date or delivery window is present in the file, you may assign this information during import. If another Mail.dat program has already populated these fields, the original information will be used.

If there are no estimated mailing dates, in-home delivery dates or delivery windows present, you may assign them. The delivery window will default to "3" when a Mail.dat file is selected.

**Conformance Testing** - the level of validation for this particular import can be selected here, ranging from "No Validation" to "PostalOne Testing". Testing level will default to your setup values but can be edited prior to import.

The "Do not Import Piece Detail File", "Do Not Import Package Quantity File" checkboxes will default to your setup values in the Program Setup tabs, but you can override them for this specific import on this screen.

If you check "Generate Statements Automatically at Import", a button will come up giving you access to enter your Statement Information.

Press OK to begin the import. The time it takes to import will vary with the density of the mailing, its entry plan and whether you are reading the data from a network or local drive. You can transfer these imported files to other users in the DAT-MAIL "TPS" format to eliminate the need to import the same files elsewhere. You can also share imported data over the network. There is no limit to how many users can view the same Mail.dat file. These functions can replace hard copy reports on the production floor if you have workstations in the proper locations.

---

**Automatic Unzip Troubleshooting**

*Importing a file whose unzipped file name is already present in your default Mail.dat directory.*

We know the file name inside the zip file by saving a list of all the "HDR" files in the directory before the unzipping is done and then checking this list after the unzipping is completed. The 'new' file is the one automatically selected so if there is no new file, the program doesn't know which file to select.

*There is more than one set of Mail.dat files in the zip file.*

The program will only select the first new file.

*The default Mail.dat path selected in the Program Setup is invalid.*

The program will unzip the files to that path (unless fast network import is enabled) so if it is invalid, the unzip will not work.
Using the Import Daemon

Import Daemon

The DAT-MAIL Daemon automates the import of Mail.dat files and is capable of performing other automated tasks such as creating and printing postage statements. For those using the Spoilage Management Module, spoilage information can be automatically imported. If you are using DAT-MAIL Toolbox you can create convenience pallets automatically for the non-palletized portion of palletized mailings.

The Daemon can be run on any computer that is set up to use DAT-MAIL, but since it does not run as a background task, you cannot use DAT-MAIL for any other functions on a computer that is running the Daemon. If you want the Daemon to run full time, you should run the Daemon on your server - or a dedicated workstation that only runs the Daemon.

You can set up the Daemon to run automatically when the computer starts up. All processes handled by the Daemon will be much faster when done from the server (rather than a workstation).

The Daemon will look (at a user-set interval) for new Mail.dat files. Once it is determined that no other program has these files open, they are imported. When the import is successful, the Mail.dat files are then moved to another folder. If the import fails, the Mail.dat file(s) will be moved to another folder reserved for defective Mail.dat files.

**TIP!** You can also use the Daemon to do any imports any time as long as you are willing to import all of the files in the import folder. The Daemon does an excellent job of replacing DAT-MAIL's multiple file import under such circumstances. Like the single file import, the Daemon can automatically unzip a .Zip file. Unlike the single file import, it can successfully import all files in the zip file when more than one set of Mail.dat files are present.

Running the Daemon from a Workstation from the Toolbar

The Daemon icon from the DAT-MAIL main menu lets you choose a specific source path for new Mail.dat files. You can set the frequency with which it checks this path from once per second to once every sixty seconds. After a path has been set, DAT-MAIL will automatically start importing any Mail.dat files, (zipped or unzipped) that appear there. If a file is successfully imported it is moved to a path of your choice (must be different from the initial import path). If it is rejected due to an import failure, it is put into the "Failed Import Path" as specified.
When you start the Daemon it displays the settings - which can be changed here. Press the Start button to begin monitoring. Mail.dat files already in the Import Path will be imported automatically.

**Import paths** are created by the DAT-MAIL installation routine and selected automatically. They can be changed by using the "Browse" buttons.

**Daemon Start Time:** The Import Daemon has an optional start time. This can be invoked manually on the Daemon's window or on auto start.

To use during Auto Start, the command line should include the /ADS for auto start followed by a space then /DMST=HH:MMxm (example: /ADS /DMST=10:00pm would start the
daemon at 10 PM.)

A message will display if an invalid time format is specified. Enter a time and click on the "Activate Start Time" checkbox to do a delayed timed import.

If you have enabled 'Automatic Statement Generation' in the Statement Tab of the Program Setup program, you will see the **Statement Setup** button appear on the screen. Press the button to enter session defaults and other information for the Mail.dat files you are importing. Refer to the **Automatic Statement Generation** section for more information.

Those users automatically generating statements with the Daemon can save the statement generation settings so they do not have to be re-entered every time the Daemon is started. After setting up the statement settings, go to the □CASS Dates, Statement Comments and more and check the "Save these settings for Import Daemon's Auto Initialize feature' checkbox. At the DAT-MAIL Import Daemon screen go to "Options" and check off the "Auto-initialize Statement Generate Setup" option.

Another important feature for mail shops using automated statement generation is the ability to automatically identify the mail shop's Client and Mailing Agent from information placed in the Mail.dat file. Mail.dat does not provide very good means of identifying either piece of information that needs to appear on postage statements so Window Book has its own solutions. Please see the **Automatic Client Identification** section of this documentation for more details.

**Batch Report Setup** is also available

---

**Stopping the Daemon**

To stop the DAT-MAIL Daemon, press the **Stop** Button.

---

**Suspending the DAT-MAIL Daemon**

You may wish to suspend the DAT-MAIL DAEMON at times, for instance when performing system backups of network drives. If a file with the name of "TURN.OFF" is put in the folder where the Daemon looks for files, it will stop importing files until this file has been deleted.

If there is a file import already in progress it will be completed, but a new Mail.dat file will not be imported until the "TURN.OFF" file is removed. The content of "TURN.OFF" is not important, just the fact the file exists will suspend the import.
Using the Daemon to Import Intelligent Inserter "SEL" files

If you are using DAT-MAIL to do electronic manifesting and you are importing files from Pitney Bowes Intelligent Inserters to post spoilage, you can put these files into the same import path as the Mail.dat files. When the DAEMON sees a SEL file, it will post the contents of that file and move it to the "Processed" directory. If for some reason, the Mail.dat file required is not yet imported, the SEL file will be moved to the "Rejected" folder.

Using the Daemon Auto-Start Feature

Create a shortcut in your Windows Startup folder with the following command line parameter (Automatic Daemon Startup).

The command line to Auto Start the Daemon from the Command line is: datmail707.exe /ADS

With this in place, the Daemon will automatically start when the computer is turned on. When the Daemon is run with this command line option it is moved to the background so that other programs can be run. If you are creating statements automatically, you must also enable the Auto-Initial Option after first saving the statement generation settings so they do not have to be re-entered every time the Daemon is started.

TIP! To use a set time during Auto Start, the command line should include the /ADS for auto start followed by a space then /DMST=HH:MMxm (example: datmail707.exe /ADS /DMST=10:00pm would start the Daemon at 10 PM.)

Daemon Auto-Initialize Feature

Important Note: You must follow these steps in the order they are presented!

Before you can enable the Daemon Auto-initialize feature you must save your statement settings.

Click on the "Options" drop-down menu to enter your defaults.
Step One: Selecting either "Generate Statements Automatically at Import" from the menu will add a button to screen, "Statement Setup".
**Step Two:** Click on "Statement Setup" and enter your default values at the "Statement Information" Tab and the "Session Defaults" Tab.
**Step Three:** Go to the tab labeled CASS Dates, Statement Comments and more and check the "Save these settings for Import Daemon's Auto Initialize option". Go back to the "Statement Information" Tab and click on the **Generate Statements** button to save the settings you just entered.

![DAT-MAIL Import Daemon]

**Step Four:** Go back to Options and select "Auto Initialize Statement Generate Setup"
Views

The Navigator

Using the Navigator

Window Book recently added a comprehensive Navigator screen to DAT-MAIL. This puts the main functions for handling of Mail.dat files on a single screen, making Mail.dat processing easier for the user. The screen below will come up by default when you choose a Mail.dat file (after having imported it):

![Navigator Screen](image)

From this screen you can choose any processing option or View that may be necessary to work with your Mail.dat files.
All of the views shown in this section are available from the "View" menu of the Navigator. Highlight and click on the appropriate menu item to enter the view that you want:
Qualification View

This is a view of the data that provides a list of containers such as trays, sacks or pallets (flats on pallets) in the top browse and a break down of the rate tiers of the highlighted container in the bottom browse.

This View initially displays your entire mailing but you have the option to use the filter buttons on the top of the screen to select individual entry points, pallets or segments for display.

In addition, you can use the Query button to select records based on a number of different criteria.

**Tabs on the Brows to Change Record Order:** The tabs on the top browse change the sort order of those records and also which field would be used to locate a record. With the Destination Zip selected, you could just start typing a container zip code to find it. If you switch to the Container Mother Pallet tab, you could find a mother pallet by just typing its number.
The "Cont. Grouping ID" tab shows you the sacks or trays in Container Grouping ID order. If you highlight the bottom browse, you can locate specific records by whatever value is described on the selected tab on the bottom browse.

**Packages vs. Containers:** The Packages/Containers buttons let you switch the view of the bottom browse from the Container Summary File to the Package Quantity file. By default, DAT-MAIL shows you the related Container Quantity records for the highlighted container in the top browse. This will show you the break out of the different rate tiers in that container and the zips those pieces are destined to. When viewing containers with Carrier Routed mail or 5 Digit mail, you can see more detailed information on the mailing when looking at the Package Quantity file which you can do by pressing the Packages button.

**Pieces vs. Copies:** The Pieces and Copies buttons allow you to switch between viewing pieces and copies on the totals displayed when working with Periodical mailings.

**Filter Buttons:** Besides locating information in the two browses, you can set filter conditions above to limit the records displayed to a particular Entry Point, Segment or Mother Pallet. Pressing one of those buttons will allow you to select a single value from a pull down list that was built during the import or all values. If you select single values for more than one button, the records displayed must meet BOTH conditions.

You can create your own filter conditions using the Query button. If a filter button or query is used, a message is displayed under the button bar at the top of the screen next to the red-lettered Filter Selections prompt. Also, when a filter button or query has been used, the total number of pieces displayed is reduced from the original total to show you only the filtered or queried mail.

**Finding Containers:** You can find a specific container very easily. The tabs at the top of the browse set the sort order. If you want to find a particular tray by Container ID for example, just select the container ID tab and start typing the desired Container ID number. As you type, the highlight bar will move closer to the desired record until you finally have found it. You can also use your mouse to scroll through the records or use the VCR buttons.

**Printing the Qualification Report:** If the user goes to the report menu and chooses to print the Qualification Report, only the containers displayed in the Qualification View will print on the report. If you have used a filter or query to display just some of the containers, only these containers will print on the Qualification report. If you need to have all records in the report, press the Clear button.

If your mailing contains 5-Digit Automation, Carrier Route or Enhanced Carrier Route containers, you will need the □PQT□ (Package Quantity file) in your Mail.Dat file set. If you are not sure whether you imported this file, go to the "View" menu and see if the Package Quantity view is available. If it is disabled (grayed out), you will need to import the file again, this time with the PQT file.

More on printing these reports appears in the "Reporting and Accounting" section.

**Changes Allowed:** You can highlight any container record and press "change" to get this screen:
You are only allowed to change certain items in this screen such as container level, entry point, trailer data and induction date. If you are planning to change more than just a few containers, you may want to do this in the Container Summary View which offers a tag table that lets you make changes for groups of tagged records. It also lets you tag these records based on a number of different criteria.

**Changing Entry Points:** In the Changing Container Summary screen press the ellipsis button next to the Entry Zipcode field.
For STD and Package Services mail, we give two lists of possible entry facilities:
One tab for NDC / SCF / DDU and one tab for Origin.

For Periodical mail, we give five lists of possible entry facilities:
One each for ADC / SCF / Origin / DDU Lookup / Transfer Hubs.
COMPONENT (.CPT) Required  Gives us the class, weight and dimensions of every mailing component. There can be multiple components, even of different classes, in a single mailing. The file defines each part of the Mail Piece Unit by the mail class.

The component view lets you specify the details of the mailing piece(s) used in the mailing. Highlighting a component record and pressing change button will allow you to change much of the information. Periodicals Mailers will need to enter new piece weights in this view to update their Mail.dat files. You will also be able to change the ad percentage in this same view. Use the 'Copy to All' button as a simple way to update all records with your change(s).
Container Quantity View

Container Quantity (.CQT) \textit{Required}

This file tells us how many pieces qualified at which rate levels within each container (tray, sack or pallet).

\textbf{Changes Allowed:} ONLY if it absolutely necessary, you can change many fields. To copy a single edit to multiple records, you can use the Tag by Range button or the white box to the left of each record to select the records and then hit the Change button.
Container Summary View

Container Summary (.CSM) Required
This file tells us how many pieces are in each tray and what the presort level of the tray is. It contains a record for each sack, tray or pallet (flats on pallets) and can indicate which mother pallet a sack or tray is located on and what kind of pallet that is. This file also carries other critical information such as entry point, mail date and other information which makes this file the 'heart' of the Mail.dat file set. Also contained in this file is the label information needed to print flags and bag/sack/tray tags.

The Container Summary file is one of the most important elements of a Mail.dat file. The information in this View can be sorted using one of the many tabs available. The Renumber Unique Cont. ID's (Pallets Only) button enables DAT-MAIL to print barcodes on Skid Tags for use in warehousing systems.

Recalc Container Weights is a procedure that reads all the containers and recalculates the csm:TotalWeight field using the current mpu:pieceWt and CQT's as needed. The reason for this is that some files may import with fairly large round-off errors in the CSM file and certain
reports may not match reports that calculate weights from CQT & MPU. This procedure allows you to recalculate the exact CSM weight to the full four decimal places.

The Container Grouping ID tab is new to our program, and offers a great way to use this valuable Mail.dat field if it hasn't already been populated in your Mail.dat file by your presort program.

Click on this tab to reveal our **Populate Container Grouping ID** button.

The **Tag by Range** button allows you to tag or untag a number of records based on the options in the screen below. The option to tag all MxADC's and MxAAADC's can be handy if some of these containers were assigned to a destination entry point and you would rather bring them to an Origin post office.

Just tag all MxADC's and MxAAADC's, change the entry point on one of the tagged records to Origin and tell it to change all tagged records. These trays are now ready for Origin entry.
This view also provides you with other tagging options for marking specific records and allowing changes to some information in the Container Summary file for all marked records. Use the checkmark icons at the top of the screen or the solid white boxes to the left of the items.

We allow for block tagging of single records on this view: Click the box of the first item and then use Shift+Left Click on the last item.

**Changes Allowed:** Here is the form you get when you edit a Container Summary record. You can change a number of fields on both tabs listed here:
Making a change to a Container Summary record when several records are marked will display the prompt below asking you to either choose Update Tagged records (applies your change to all marked records) or Skip Tagged records (will only change the highlighted record).
The new tab called "Label Info" is where your container label information is held and may be modified.

Use the **Copy Origin Line** button if you would like to reset the Origin location of your tags before printing.

You can easily do this by changing the information on one tag and then selecting the **Copy Origin Line** button.
Original Container Identification File View

You can get to this view from the Navigator - Open the Mail.dat file then choose "View" => "Original Identification File View" from the menu. Click here to get this screen:

Click the Change button to access a record's individual information:
Mail Piece Unit File View

**Mail Piece Unit (.MPU) Required**
Details the physical attributes of each individual mail piece, such as piece weight and in the case of Periodicals, ad percentages. Co-mingled mail, Co-palletized Mail, or other non-identical piece weight mailings can have multiple Mail Piece Units associated with a Segment; otherwise a Mail Piece Unit ID cannot cross Segment.

A mail piece unit record can summarize multiple component records and the total weight is used in Mail.dat and carry piece weights. There is usually one MPU record per piece weight and segment. We do provide a shortcut in allowing the mailer to change piece weights.

**Note for Periodicals Mailers:** Mail.dat requires you to change your piece weight in the "Component File View". Your piece weight in the MPU View is grayed out and inaccessible from here. Go to the "Component File View" to enter new piece weights.
If you have an identical weight mailing and wish to change the piece weight for all MPU’s, just change the first piece weight by highlighting it and pressing Change. Enter the new piece weight and save. Highlight the changed records and press the Copy Weights button. It will copy the new piece weight to all MPU records and recalculate all of your container weights along with the total weight of the mailing. You may also use Copy Ad% and Copy Desc. in the same manner.

**Tip!** Copy to New - This is a great feature for version substitution. Version substitution is used when the piece weight for some of your mail has changed during plant production.
Each Mail.dat file must have at least one MPA record. This file contains information about the party responsible for paying the postage due.
Package Quantity View

Package Quantity (.PQT) Choice file, 1 of 4
This file tells us where each package or bundle is going, and how many pieces are in each. Information from this file is required to properly print the qualification reports. This file is required also for PostalOne! in other cases, use of this file may be optional.

The Package Quantity file contains information on how the mail has been packaged. This data is required to print qualification reports.
**Piece Detail File View**

**Piece Detail File (.PDR) Choice file, 1 of 4 used with .PQT**
This file is used in manifest mailing and by presort vendors going through USPS' PAVE certification.

This view is used in recording spoilage for manifested mailings. Spoiled pieces can be marked by highlighting a record and clicking on the "torn letter" icon at the top of the screen or click the **Change** button and place a checkmark on the "Spoiled" box.

To unmark a spoiled record, click **Change** and uncheck the "Spoiled" box.
Valuable reports can be run after your spoils are marked for USPS verification. These Spoilage Reports are located under the Reports menu.

The 4 State Barcode field is used for USPS Confirm mailings. If you have purchased our optional Confirm module and are placing that data into the PDR file, our program will read and apply that information when statements are generated. You must also set the Confirm Indicator field in Segment File to Variable in SPR (PDR).
**Piece Barcode File View**

You can get to this view from the Navigator - Open the Mail.dat file then choose "View" => "Piece Barcode File" from the Navigator menu.

Click to get this screen:

Click the **Change** button to access a record's individual information:
Job Number: POSTCARD
Segment ID: 0001  Container ID: 000001
CQT Database ID: 1
Package ID: 000001
Barcode: 00250901254001345571900011589306
Wasted or Shortage Piece: None
**SEGMENT File (.SEG) Required** Identifies each presort group. Mail that requires different processing from other pieces in the same mailing are to be separated by segment. Segmenting should not be used to differentiate Entry Points, unless they are being processed in different categories. Segmenting should not be used as a work around for reporting, especially when the reporting information is contained in another accessible area of Mail.dat.

"Segment" is a user-defined way of breaking a mailing into unique multiples - whether it is multiple versions, strings, lists, drops, etc. Viewing this file will tell you how the Mail.dat file was segmented by the presort process.

Clicking the **Change** button to access and edit information, including the dates for your CASS information. These dates will automatically update to your postage statements when they are generated.
Changes to the Verification Facility and Verification Facility ZIP+4 fields will change the Origin location that prints on your Pallet Placards.

If you purchased our optional module for the USPS Confirm program, you can enter your 4 State Barcode (Planet Code) information in the Static Confirm Code field and indicate "Static" in the Confirm Indicator field if this has not already been populated by your presort program. If your Confirm data is located in PDR or MIR, be sure to choose the appropriate selection in the Confirm Indicator field.
Change Weights View

A quick and easy View to allow for one of the most common Mail.dat edit functions - changing your piece weights.

Use the Tag Icons at the top of the screen to select those items you wish to change

Or use the **Tag by Range** button
Or simply click on the left side box of each record you want to change.

![Select Range](image)

Click on the **Change** button, and it will give you access to edit the Weight field. Change your Weight. Hit the <Enter> key when you are finished then click on the **Process Changes** button. Answer **Yes** when prompted to confirm changes. Once the changes have been processed, your screen will be updated to reflect the changes.
Entry View

The Entry View provides a list of all the entry points that the mailing has been presorted to be entered at. You can expand the node for each entry point to see which non-palletized trays and sacks are going to the entry point and see a list of all pallets going to an entry point. You can even expand a pallet to show the trays or sacks on that pallet.

![Entry View - MM1007 Periodic Mailing](image)

**Changes Allowed:** You can change the entry point of a record by highlighting it and pressing the change button. You can then select a new entry point. **Note:** The Change button also displays fields for changing the scheduled mail date, in-home delivery date and delivery window for all containers to be entered at that entry point. We are removing those fields in a future release since we require you to use the Mail Schedule View for those purposes.

From here you also have access to Quick Plan or Planalyzer processing to change the current entry plan based on rules you define. Just hit the Quick Plan or Planalyzer button to gain access.
You will see the Quick Plan button if you have DAT-MAIL Editor:

Quick Plan

You will see the Planalyzer button if you have DAT-MAIL Editor with Toolbox:

Planalyzer
Mail Schedule View

This is one of the most versatile Views in DAT-MAIL. It shows your mailing by Entry Facility; Estimated Mail Date; In Home Date; Delivery Window; Number of Pieces; Number of Copies. Your mailing can be sorted (viewed) by selecting one of the many options listed in the Sort Order and Detail Level drop-down box.

Use the Tag buttons, Tag by Range option or the White boxes to the left of each line item. Or you can make a similar change such as Mail Date, Drop Date, In-Home Date and/or Trailer and Stop information to a number of records at one time.
Use <Shift>+Left Click and <Ctrl>+Left Click to tag a number of records. Once your items are tagged, make sure your cursor is highlighting a tagged record and then click on the **Change** button (or double-click).

After your drop information has been established in this View you can utilize one or both of the Export button options.

Use the **Export CSV** button to tag and export a tab-delimited file with columns for: Job Number, Package, Drop ID, Mail Date, First In Home Date, Last In Home Date, Piece Weight, Mail Class, Processing Category, Non-Standard Flag, Non-Profit Flag, Permit Number, Container Type, Payment Method, Facility Type, Entry Point, Facility Name, Rate Code, Rate Description, Postage Rate, Postage Amount, Pieces, Container Group ID, Destination Entry, and Zone as applicable.
The Priority Mail Drop Ship Export button will not appear unless you have the "Export information" option chosen in Program Setup on the Export/Archive tab. DAT-MAIL subscribers can open their Mail.dat® presort data files in DAT-MAIL, go to this Mail Schedule View, tag the appropriate entry facilities to create Priority drop ship labels, and export them at the click of a button.

Window Book's Postal Package Partner (PPP) program can then import the Priority Mail drop ship data with a few mouse clicks, allowing users to tag these records and print their labels in batch mode. This PPP feature enables these industry-leading postal mailing and shipping software systems to work together, creating a streamlined process for mailers and shippers who need to process Priority Mail drop shipments as quickly as possible.

Business Management System Module users will see an applicable Export button that corresponds to their particular system.
A Mother Pallet is a pallet with trays or sacks on it that has been palletized through a presort program. The browse is split horizontally to mimic our Transportation View. The top browse can be viewed by using either the Entry Point or Pallet ID tab. The bottom browse holds a view of the containers that make up the highlighted item in the top browse. The bottom browse also indicates what Pallet ID the containers reside in and also provides you with a "Number of Containers" total.

**Changes Allowed:** You can change the Entry Point Facility of entire pallets, create new Pallets and/or User Pallets (convenience pallets), assign ship dates, trailer/stop numbers, etc. You can also access our Palletization program from this view if you wish to perform "re-palletization" (must have Toolbox or the optional Palletization module with Editor).

On a First Class file, for example, there are normally no existing pallets - so the Mother Pallet View will be empty. Hit Insert to create your first Pallet/User Pallet. You will be prompted to select a Segment:
A Mother Pallet ID# will be generated by our system using the next incremental Container ID in your file. Be sure to choose the Mother Pallet Type you want - the Mother Pallet Level field value will automatically populate based on your choice - then choose the Destination Zipcode and Entry Zipcode. If you’re working with a First Class file, the Entry Zipcode must match the origin zip code listed on your containers. Once the Pallet record is created, click OK.

Now click on the Assign Containers to Pallets checkbox to reveal the list of available containers in your file.

Tag the containers you want to add to the newly created Pallet/User Pallet. Windows tagging convention is available by tagging the first container then using shift+left click on the last container. Move the containers onto the Pallet/User Pallet by clicking on the double left arrow button.

To remove containers from a Pallet/User Pallet, tag them then click on the double-right-arrow button. The Number of Containers value will be updated according to your container selection. All applicable DAT-MAIL reports will now display information based on the creation of your Pallets/User Pallets such as Trays/Sacks on Pallet, Pallet Production Worksheet, etc.
Transportation View

This View provides you with a display of your Entry Points and the containers listed in each. The top half of the browse contains your list of Entry Points and as each one is highlighted, you can see the containers listed in the bottom half of the browse. You have access to perform Quick Planning or Freight Planning from this view.
Generate Statements View

Make sure that the "Generate Postage Statements" option has been selected in DAT-MAIL Program Setup on the "Defaults" tab. Once this is selected, you will have Generate Statements available as a View. If you need to change the piece weight of your file before you generate your postage statements, please reference the Mail Piece Unit View and Component File View information on how to do this properly.

This View gives you access to tag (i.e. select) destinations, pallets, containers, or segments for statement generation.
Floating Batch Manifest View

For manifest mailers.
File Information View

This view details the information from the MAIL.DAT header (.HDR) file.

Information includes Job ID; Idealliance MAIL.DAT Version; Job Number; Job Name; File Source; Provider Code; Contact Information; Date and Time Prepared; and Segment Criteria.
Job/Mailer Information View

Job and Mailer Information

Job ID: 00000002   Job No.: MM1007
Version: 12-2      Job Name: Periodic Mailing

Mailer: WBI TEST ONLY
Address 1: 300 FRANKLIN
Address 2:
City: CAMBRIDGE
State: MA   Zip: 02139   Phone: (617) 441-3500

Close
DropShip Database

(This feature requires a DAT-MAIL Toolbox Registration)

The DropShip Database helps with transportation planning and contains an easy-to-use compendium of the US Postal Service drop ship database for mailers and transportation companies. Using the USPS drop ship database, we organize the information by entry facility type, city, state and zip code. The information is updated on a regular basis, with information provided by the USPS.

You can Access the Dropship Database from the Main menu under Toolbox:
From here you can access easy-to-use tables:
Click on the **View** button to see detailed information on a highlighted site:

![View Facility Information](image)

You can even control the data by making a Temporary or Permanent site change edits.
Click "Export" to get a list (In CSV format) of NDCs, SCFs, ADCs or DDUs or All Facilities: